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INTRODUCTION 
 

The materials in this manual are binding upon a paper or thesis writer at Detroit Baptist 
Theological Seminary. Style procedures in this manual are based significantly on Kate L. 
Turabian, A Manual for Writers of Research Papers, Theses, and Dissertations, 7th ed. 

(University of Chicago Press, 2007) and the capitalization and abbreviation guidelines on The 
SBL Handbook of Style for Ancient Near Eastern, Biblical, and Early Christian Studies 
(Hendrickson, 1999) and Robert Hudson, A Christian Writer’s Manual of Style (Zondervan, 
2004). While this manual attempts to be as thorough as possible, some details, especially obscure 
bibliographic forms and abbreviations, are necessarily omitted. Writers should consult Turabian 
and the SBL Handbook for issues not addressed in this manual. For style issues not addressed in 
Turabian, writers should consult The Chicago Manual of Style, 15th ed. (University of Chicago 
Press, 2003). When the instructions in this manual conflict with any of these primary sources, 
however, writers are to follow the instructions in this manual. For specific projects individual 
professors may also make modifications to these instructions at their discretion. 

 

 

PART 1: PLANNING THE PAPER 
 

Most seminary papers are primarily library studies, or what Webster calls a “close searching” of 
written materials, which involves not only a studious inquiry into the subject but also a critical 
examination, assessment, and interpretation of the materials found. The results should be set 
forth in an accurately, clearly and forcefully expressed, well organized, and properly documented 
paper.  

 

There are five basic parts of paper-writing: (1) reading broadly in the field and specifically the 
course topic, (2) choosing a specific question to answer, (3) collecting and reading research 
materials on that specific question, (4) planning a paper that answers the question, and 
(5) writing the paper. Every seminary student should be continuously involved in steps 1–3, 
sometimes reading broadly and sometimes pursuing narrower topics of interest to conclusions. 
This manual will assist especially in these latter steps of paper-writing. 
 

Choosing a topic: While reading broadly within a given area of study, the student will generate 
questions that call for more exhaustive research. Some of these questions are good topics for 
research papers. Some are not. A good research topic will be: 

 

• Worthwhile. This is a very subjective characteristic. A good research question will have 
some contemporary value, will not find a unanimous answer among writers, and should 
interest the student. Sometimes the instructor will assign topics or lists of suggested 
topics to assist in this selection. 

• Manageable. In general, students tend to think of subjects too large to be treated 
satisfactorily in the length of paper assigned. Avoid a topic calling for a background of 
knowledge that you do not possess. 

• Feasible. Choose a topic for which there is available information in libraries to which 
you have access. You will need to secure original sources. 

• Acceptable to the instructor. If there is any doubt, ask. 
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Collecting bibliographic sources. With the vast amount of materials available in today’s 
theological libraries, finding good materials can be a daunting task. But the task has actually 
changed very little. Look for materials in this order: 
 

• Encyclopedia and dictionary articles. These provide a survey of the topic, together with a 
short bibliography of the most pertinent sources. 

• Bibliographies. Most topics already have some sort of bibliography available. Some are 
bound, annotated bibliographies and others take the form of periodical articles, but most 
are simply appended onto published books and dissertations on the topic. 

• Card catalogs and OPACs (Online Public Access Catalogs). Today’s technology makes 
it possible to research a topic through online catalogs that inform the researcher what is 
available not only in his local library, but also in hundreds of other libraries whose 
resources are available via interlibrary loan for a small fee and a short processing period. 
(Most interlibrary loans take between one and two weeks to fill.) 

• Periodical indexes. As the student advances in his studies, periodical articles and essays 
will become a greater percentage of his sources. These sources are usually very detailed, 
and represent the most up-to-date materials on given topics. It is essential for students to 
learn to use these resources. 

• Footnote trails. So long as a student is still reading, his collection of bibliographic 
sources is not complete. While reading books, essays, and periodicals, the student will 
become aware, through footnotes, of other pertinent sources. These footnote trails often 
prove to be the best bibliographic source of all. 

Evaluating bibliographic sources. The bibliography in a research paper should not be a list of 
every work the student can discover which relates to his topic. It should be limited to those 
sources that actually proved useful to the student. Several questions may be asked in evaluating 
sources: 
 

• Is it a primary or secondary document? Secondary documents provide commentary on 
previous discussion by other authors. One cannot avoid using these. However, these 
should never be used exclusively. See also the note on secondary citation below. 

• Is the author qualified? A serious academic paper concentrates on materials published by 
scholars writing within their field. 

• Is the author biased? An exploration of authors’ denominations, experiences, schools, 
instructors, and other history can unearth significant biases that can jeopardize academic 
professionalism.  

• Is the source up to date? Though we have a rich theological heritage, old scholarship is 
not necessarily the best scholarship. Modern linguistic and archaeological studies, to say 
nothing of the compounded refinement of exegesis and theology, have vastly improved 
the quality of commentaries and have refined and contemporized theological discussions. 
While the contemporary student stands on the shoulders of earlier creeds and theological 
studies, he must also refine and increase his knowledge of truth by probing newer studies 
as well. 
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Gathering bibliographic data. From the very beginning of his research the student is urged to 
be meticulous in gathering bibliographic data. Such a habit will eliminate a hasty scramble 
through the library stacks to retrieve a publication date, page numbers, or a translator’s name.  

 

Be careful to record the full names of all authors, editors, and translators. When dealing with 
reprints, be careful to record the reprint date as well as the original copyright date if available. 
When using a periodical be sure to note the volume, issue, and date of the article, and record the 
inclusive page numbers of an entire periodical article. Give attention to names of monograph 
series and to total volumes in a multi-volume set. This information will all be necessary for a 
correct bibliographic entry. 
 

In its broadest (and normal) form the bibliography includes only those sources actually employed 
by the student—those that contributed to the development of the content of the paper. In its 
narrowest form it may include only those sources actually cited. DBTS papers and theses should 
normally contain a bibliography of sources consulted, though it will usually be titled simply 
“Bibliography.” A bibliography should not be divided into sections with such titles as “Books,” 
“Lexical Aids,” “Commentaries,” etc. All items should be integrated into one complete listing 
with all bibliographic information. 

 

Documentation.  All papers must be adequately documented. Documentation (footnotes) must 
not be limited to only those instances of direct quotation. A summary or statement of an author’s 
position, even when reworded by the student, must be documented. Frequent quotation is not 
synonymous with good documentation. A paper may have very few quotations yet be well 
documented. 

 

A research paper should be an original critical evaluation and analysis of all available data. A 
major element of a research task is to evaluate each author and be able to express his view in 
one’s own words. Do not include quotations for the sake of including quotations. Direct 
quotations are usually necessary only when an author’s exact words are essential to the argument 
or when a significant thought has been expressed particularly well, and should be used very 
sparingly. Gordon Fee (New Testament Exegesis, 3rd ed. [Philadelphia: Westminster/John Knox, 
2002], p. 34) gives the following advice: 

 

• Quote when it is necessary or important to use the very words of an author so as not to 
misrepresent. 

• Quote when it is necessary for a clear or convincing presentation of an option. Many times a 
quotation of this kind will stand at the beginning of a section or paragraph as a point of departure. 

• Quote when it is useful for the psychological impact on the reader. For example, it is often useful 
to quote some well-known authority who holds the opinion you are contending for. Sometimes 
this is especially helpful if what is said may be contrary to one’s ordinary expectations. 

• Quote when an author clearly says something better than you could, or when it is said in a clearly 
memorable way. 

Never make a secondary citation if the original source is available, and never cite an electronic 
source if a print source is available. If electronic citation is unavoidable, follow the style 
demonstrated on pages 35–38 of this manual. 
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PART 2: WRITING THE PAPER 
 
Preparing to draft. No one should attempt to draft until he (1) knows the question he plans to 
answer, (2) has done sufficient reading to know his answer, (3) has molded that answer into a 
thesis, and (4) has an outline (usually written) he plans to follow in proving his thesis. An outline 
will allow the student to: 
 

• identify what information he already has on a topic. 

• identify a logical arrangement for this information.  

• confirm a controlling idea (thesis) for the paper. 

• discover places where his information is incomplete as well as those where it seems 
irrelevant. This is essential for further collection of material, reading, and note-taking. 

 

Drafting the paper. There is no “right” way to draft. Booth, Colomb, and Williams identify two 
styles of drafting: a “quick and dirty” style where the writer, as quickly as possible, puts 
everything on his paper without thought for editing issues, and a “slow and clean” style where 
the writer creates a polished first draft (The Craft of Research, pp. 165–66). Both styles, 
however, involve multiple revisions and rewritings, the single most essential part of lucid 
writing.   
 

Writing style. Seminary papers should reflect an attitude that is formal, detached, and serious. 
Their purpose is to present your materials factually in an accurate, complete, and well-ordered 
report. Humor and witticisms are unacceptable; emotionalism and exclamations should be 
minimized; contractions, slang, and popular clichés (e.g., “this doesn’t hold water”) should be 
eliminated. Avoid frequent references to yourself in the first person. This limits use of the 
editorial “we” as well as “I.” Eliminate usage of second person pronouns (you should not, etc.). 
Restructure sentences to avoid overuse of “this writer” or “the writer.” Avoid unnecessary 
repetitions by employing synonyms and varied expressions (use a thesaurus). Do not use titles 
(brother, Dr., etc.) unless they are essential.  
 

Grammar and syntax. Struggle to construct good sentences. Vary words and, of course, spell 
words correctly. Since use of the passive voice softens and weakens statements, use primarily 
(though not exclusively) the active voice. Avoid repetitive phrases and transitional devices, and 
do not use a transitional device in every paragraph. Eliminate faulty parallelism. Construct 
coherent, unified paragraphs with a single thesis. Vary sentence structure, but avoid 
unnecessarily long sentences, paragraphs, and sections. As a general rule, if a sentence extends 
longer than three lines it will usually help to divide it into two sentences. If a paragraph extends 
longer than one page it can probably be logically divided into two paragraphs. If a section 
extends longer than five pages without a new subheading, the organization can probably be 
improved by employing another level of subheading to divide the material. 
 

Brevity. A long paper is not necessarily a good paper. In fact, it usually is a bad one. Though 
there are many examples to the contrary, academic writing need not be verbose. The excellent 
writer, whatever his discipline or audience, must trim the “fat” (unnecessary words) from his 
writing. This is not to say, however, that his writing must be reduced to the simplest reading 
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level. The academic writer must learn to use complex and varied sentence structure and a depth 
of vocabulary commensurate with his audience. A simple but popular guide to developing a 
concise style is William Strunk, Jr., and E. B. White, The Elements of Style, 4th ed. (Boston: 
Allyn and Bacon, 2000). 
 
 

PART 3: FORMATTING THE PAPER 
 

Computer settings for research papers. All papers must be prepared on a computer or 
electronic word processor. Microsoft Word is highly recommended though not required. 
Supplemental templates and sample pages formatted in Microsoft Word are available on the 
DBTS website for the convenience of the student. 
 

Paper. Use quality 20-pound weight paper (standard copy paper). Do not use colored paper or 
lighter “typing” paper. Normal classroom papers are to be secured with a single staple in the 
upper left hand corner. Do not use report covers of any kind. Th.M. theses are bound. 
 

Fonts. Use a black, 12-point Times New Roman font throughout the body, preliminary pages, 
and bibliography of the paper. Use the identical font style in footnotes, but reduce the font size to 
10 points. Do not use monospaced or sans serif fonts. See section 5 for protocol differences 
between typewritten monospaced fonts and computer-generated proportional fonts. 

 

Titles of whole published works (books, periodicals, newspapers, magazines, etc.) should be 
italicized. Other titles (e.g., syllabi, theses, or essays and articles that are parts of a published 
work) should be enclosed in quotation marks. 
 

Sparing use of italics may also be used for emphasis. Under no circumstance should the student 
make emphasis using underlining, capitalization, bold fonts, or altered font sizes and styles, 
except as specifically required by this manual for headings. Italics also set apart isolated foreign 
words and phrases that may be unfamiliar to the reader, but not for foreign words that have 
become such a part of common English parlance that they appear in the Merriam Webster’s 

Dictionary (e.g., contra, vis-à-vis). Latin abbreviations are not italicized.  
 

The names of modern versions of the Bible are placed in italics, unlike the names of important 
historical versions of the Bible, which are set in Roman (non-italic) type: 

 

the Breeches Bible  The Jerusalem Bible 
the King James Version  The New King James Version 
The New International Version   the Vulgate 

 

A word referred to as a word should be italicized (except for words written in Greek and Hebrew 
fonts). Its definition should be in quotation marks. However, when a word is quoted from a 
specific context, quotation marks, not italics, should be used: 
 

• Early Methodist ministers used the word liberty to describe an openness to God’s Spirit 
in their preaching. 

• By feretory hagiographers mean “a shrine in which a saint’s bones are deposited and 
venerated.” 
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• The word world has various meanings in Scripture: in John 3:16, for instance, the 
Evangelist writes “world” to denote the inhabitants of our planet, not the broader cosmos. 
The Greek word kovsmo" is the term used. 

 
Greek, Hebrew, and Aramaic terms may not be transliterated in seminary papers except within 
the title, when quoted directly from another source, and in unusual cases where comparative 
linguistics is involved. Students may not insert Greek, Hebrew, and Aramaic terms by hand but 
must use non-italicized computer fonts. Greek words should include all accents and breathing 
marks, and Hebrew and Aramaic words should be properly pointed. A Greek word that begins a 
sentence must have its first letter capitalized as in English.  
 

Small caps should be used for such abbreviations as A.D., B.C., P.M., MS, and MSS. Abbreviations 
of translations and versions of Scripture are usually set in small caps. See pages 37–39 of this 
manual for a listing of proper abbreviations for the various versions. 
 
Line spacing. Use double-spacing in the body of all papers. Use single-spacing for the contents 
of footnotes and bibliographic entries (but double space between each entry), for multi-line 
headings (except on the title page, where a double space is used), and for block quotations. Your 
word processor should be set to allow widows and orphans. 
 
Margins. Use a one-inch margin on all four sides for research papers. For the Th.M. thesis, use a 
1½-inch left margin to accommodate binding. A two-inch upper margin is used for major section 
headings (for normal classroom papers this includes the first page of text and the bibliography; 
for theses, this also includes the first page of each chapter and each section in the front matter).  
 
Indentation. Use left justification only; do not use right or full justification. The first line of 
each paragraph and footnote is indented ½ inch. Indent a block quotation ¼ inch from the left 
margin, and indent the beginning of each paragraph within a block quotation another ¼ inch (½ 
inch total). Block quotations should not have a paragraph indentation unless the material quoted 
begins a new paragraph in the source being quoted. Use a ½-inch hanging indention for 
bibliographic entries (i.e., the first line flush with the left margin and each succeeding line 
indented ½ inch).  
 
Page numbers. Pagination in Arabic numerals (1, 2, 3…) begins on the first page of text, and 

continues through the bibliography. Page numbers on the first page of each document section (see 
below for a delineation of each of these) should appear centered at the bottom of the page ½ inch 
from the edge of the paper. On all other pages of text the page number should appear one inch 
from the right edge of the paper and ½ inch from the top edge. 
 
Preliminary pages are numbered with small Roman numerals (i, ii, iii, iv, v, etc.) centered at the 
bottom of the page, ½ inch from the bottom edge. However, since pages that have no text 
material receive no page number, these will not appear on normal classroom papers. In the Th.M. 
thesis the actual numbering begins with v (the first page of the table of contents) since the title 
pages counts as page i, the blank page which follows counts as page ii, the abstract counts as 
page iii, and the acceptance page counts as page iv. 
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Formatting Your Paper in Microsoft Word XP/2003: How to Do It 
 

 

Fonts 
 

Click on the Format drop-down menu. 
Choose Font. 
Select Font: Times New Roman. 

Select Size: 12 

Select Font Style: Regular or Italics as 
appropriate. 

Check Effects: Small Caps as appropriate. 
Click OK. 
 

Note: You can perform these steps more 
quickly by displaying the Formatting 

Toolbar on the View drop-down menu. 
 

Line Spacing, Indentation, and Alignment 
 

Click on the Format drop-down menu. 
Choose Paragraph. 
Choose the Indents and Spacing Tab 

Select Alignment: Left. 
 Under Indentation select: 
  Left: 0.25” for block quotes. 

Special: First line by 0.5” for body 
text and footnotes.  

Special: Hanging by 0.5” for 
bibliographic entries. 

Under Line Spacing select: 
Double for regular text. 
Single for footnotes, bibliographic 

entries, and block quotes.  
After: 0 pt for regular text. 
After: 12 pt for bibliography and 

footnote entries. 
Choose the Line and Page Breaks Tab. 
 Unselect all four boxes under Pagination. 
Click OK. 
 

Margins 
 

Click on the File drop-down menu. 
Choose Page Setup. 
Choose the Margins tab. 
Set top, bottom, left, and right margins at 1”. 
Set header and footer margins at 0.5” 
Click OK. 
 

Pagination 
 

Click on the File drop-down menu. 
Choose Page Setup. 
Choose the Layout Tab. 
Click Different First Page. 
Click OK. 
 

Click on the Insert drop-down menu. 
Select Page Numbers. 
Select Position: Top of Page (Header). 
Select Alignment: Right. 
Unselect Show number on first page. 
Click OK. 
 
Click on the View drop-down menu. 
Select Header and Footer. 
Scroll to the first page of text and enter the 

First Page Footer text box. 
In the Main Formatting Toolbar select Center. 
In the Special Header/Footer Toolbar select 

Insert Page Number 

Close the Special Header Footer Toolbar. 
 
For Th.M. Theses only: 
 Click on the Insert drop-down menu. 
 Choose Page Numbers. 
 Choose Format 
 Choose the appropriate Number Format 

for the section in view: 
     (1, 2, 3…) for text pages. 
     (i, ii, iii…) for preliminary pages. 
 To enable continuous numbering of pages 

and footnotes, check the box Continue 

from previous section. 
 Click OK. 
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Formatting Your Paper in Microsoft Word 2007: How to Do It 
 

 

Fonts 
 

Click on the Home tab (default). 
Open the Font dialog box launcher. 
Click on the Font tab (default). 
Under Latin Text select the following: 
 Font: Times New Roman* 
 Size: 12* 

Font Style: Regular, Bold, or Italics as appropriate.* 
Effects: None, All caps, or Small Caps as appropriate. 

Click OK.† 
 

Line Spacing, Indentation, and Alignment 
 

Click on the Home tab (default). 
Open the Paragraph dialog box launcher.  
Click on the Indents and Spacing tab. 

Under General, select Alignment: Left.* 
Under Indentation select: 
 Before Text: 0.25” for block quotes.# 

Special: First line by 0.5” for body text and 

footnotes.# 
Special: Hanging by 0.5” for bibliographic 

entries.# 
 Under Line Spacing select: 

Double for body text. 
Single for footnotes, bibliographic entries, and 

block quotes.  
After: 0 pt for regular text. 
After: 12 pt for bibliography and footnote 

entries. 
Click on the Line and Page Breaks tab. 
 Uncheck all four boxes under Pagination, including 

the box marked Widow/Orphan Control. 

Click OK.† 
 

Margins 
 

Click on the Page Layout tab. 
Open the Margins drop-down menu. 
Select Custom. 

For normal classroom papers, specify 1” for all four 
margins. 

For Th.M. theses, specify 1” for the top, bottom, and 
right margins, and 1.5” for the left margin. 

Click OK.† 
 

Sections 
 

When beginning a new section (e.g., the body, 
bibliography, and in Th.M. theses, chapters) click on 
the Page Layout tab. 

Find the Page Setup tab. 
Click on Breaks. 

 
In the Drop-down menu, select Section Breaks, Next 

Page. 
Do not use the Insert/Page Break option for this function. 

 

Note: This step is necessary to facilitate pagination (see 
below). 

 

Pagination 
 

For regular body text: 

Click on the Insert tab. 
Find the Header & Footer tab. 
In the Page Number drop-down menu select Top of Page. 

In the Top of Page drop-down menu select Plain Number 

3 (right justified). 
A Design toolbar will immediately appear. 
Under the Options tab check Different First Page. 
While in the first page of your paper, find the Header & 

Footer tab again. 
In the Page Number drop-down menu select Bottom of 

Page. 

In the Bottom of Page drop-down select Plain Number 2 
(centered). Note: There is a glitch in MS Word 2007 
that places a line space after the page number at the 
bottom of the page. This extra space should be 
removed. 

Click on Close Header & Footer. 
 

For preliminary pages of the Th.M. thesis: 
 

Click on the Insert tab. 
Find the Header & Footer tab. 
In the Page Number drop-down menu select Format Page 

Numbers 

From the Number Format drop-down menu select (i, ii, 
iii,…) 

Click OK. 
On the first page of text, repeat these steps, selecting 

number format (1, 2, 3,…). In the Number Format 

drop-down menu be sure to uncheck the Continue 

from previous section option and specify that page 
numbering is to start at page 1. 

 
 

*These actions may be performed more quickly in the 

respective minibars.  
 
#
 These actions may be performed more quickly in the 

ruler. To use the ruler, click on the View tab, find 

the Show/Hide box, and check the box for Ruler. 
 
†
These changes may be made part of the “normal” 

template by clicking default instead of OK. 
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PART 4: PARTS OF THE PAPER 
 

A standard classroom paper has three sections: (1) the title page, (2) the body of the paper, and 
(3) the bibliography. The Th.M. thesis has seven sections: (1) the title page (followed by a blank 
page), (2) the abstract, (3) the acceptance page, (4) the table of contents, (5) the list of 
abbreviations, (6) the body of the paper subdivided into chapters, and (7) the bibliography. Each 
section (with the exception of the title page) begins with a section header centered in ALL CAPS 
two inches from the top edge of the page. 
 
Title page: The title should express in the clearest possible terms the subject matter of the thesis. 
Avoid the extremes of short, cryptic titles and unnecessarily long, ostentatious titles. Eye-
catching titles, arcane allusions, and clever gimmicks are better suited to the best-selling books 
than to scholarly papers. Superfluous phrases (“An Intensive Examination of…”) should be 
omitted. Proper grammar and punctuation should be observed. If Greek and Hebrew words are 
used in the title, they should be transliterated.  
 
Normal classroom papers (see sample page A): Each line of the title page is centered between 
equal margins of 1 inch. The lines are as follows: 
 

• The school name (Detroit Baptist Theological Seminary) appears 1½ inches from the top 
edge of the page. 

• The title of the paper appears in ALL CAPS beginning 2¼ inches from the top edge of 
the page. No line of the title should exceed 5 inches; lines of 4 inches or longer may be 
subdivided. Arrange the lines in an inverted pyramid and double-space them. If the title 
includes both a title and subtitle, the title should appear on one line followed by a colon, 
and the subtitle should appear on a separate line or lines. The inverted pyramid rule may 
be suspended only in this situation. A title should rarely exceed three lines, and may not 
exceed four lines. 

• The word by appears 5¼ inches from the top edge of the page, followed by a double 
space and the author’s full given name (a middle initial is acceptable). 

• Nine inches from the top edge of the page is a line containing three elements: (1) the 
course name followed by a colon, (2) the course number followed by a comma, and (3) 
the regularly scheduled meeting time for the class.  

• After a double space include the name of the instructor followed by another double space 
and the due date for the paper. 

 
Th.M. theses (see sample page B): Each line of the title page is centered between a left margin of 
1½ inches and a right margin of 1 inch. The lines are as follows: 
 

• The title of the paper appears in ALL CAPS beginning two inches from the top edge of 
the page. The same rules for classroom paper titles apply to thesis titles. 

• The word by appears 5¼ inches from the top edge of the page, followed by a double 
space and the author’s full given name (a middle initial is acceptable). 

• Nine inches from the top edge of the page the following single-spaced entry should 
appear in sentence capitalization format: 
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Submitted in partial fulfillment of requirements 
 for the degree of Master of Theology at 
 Detroit Baptist Theological Seminary 

May 2001 
 

Blank page.  A blank page should only be used in theses, not normal classroom papers. 
 

Abstract.  The Th.M. thesis (not normal classroom papers) must include an abstract that will 
appear after the title page and blank sheet. It is not mentioned in the table of contents. It must be 
limited to one page and must be single-spaced. The margins should be the same as for the body 

of the thesis, and the heading should follow the format shown in the sample abstract (see sample 
page C). An abstract is a capsule statement of the principal areas of investigation, main lines of 
argument, and chief conclusions of the thesis. It is a self-contained summary and not an 
evaluation or description of the thesis. An abstract should provide a quick glance at the contents 
and conclusions of the thesis. “Abstracts should not promise, predict or tantalize; they should 
deliver in sum what the essay pays out in full account. The preparation of a lucid abstract is the 
final test of an author’s control of his material” (Semeia 1 [1974]: 278). 

 

The following information should appear single-spaced at the top of the abstract page: title of 
thesis, author, degree, date, advisers. The abstract should be arranged in paragraphs. The first 
paragraph should make clear the content of the passage and/or the nature of the problem 
involved. In general there should be no quotations in the abstract. Main lines of argument should 
be capsulized, but it is improper simply to list chapter titles or headings. The principal 
conclusions of the thesis must be crystal clear in the abstract.   

 

Acceptance page. An acceptance page must follow the abstract in a Th.M. thesis only (see 
sample page D). The acceptance page includes: 

 

• The following statement, centered and double spaced in sentence capitalization format, 
beginning 4 inches from the top edge of the page: 
 

Accepted by the Faculty of Detroit Baptist Theological Seminary 
  

in partial fulfillment of requirements for the degree 
 

Master of Theology 
 

• A centered, 3-inch signature line for each adviser. The first line should appear 6 inches 
from the top edge of the page, and successive lines at 1-inch intervals for each adviser. 
The word Adviser should appear directly beneath each line 
 

Table of contents. The Th.M. thesis (not normal classroom papers) must include a table of 
contents. The first item listed in the table of contents should be the list of abbreviations. Bold and 
italic fonts are not used in the table of contents; different levels of subheadings are shown by 
indention. Also note that decimal tabs must be used to align the periods after each chapter 
number, and a right tab to align the page numbers on the right margin. Take note of sample page 
E for assistance in these details. 
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List of abbreviations. Any thesis using abbreviations must include a list of all abbreviations 
used in the thesis (see sample page F), including those that appear on the approved list on pages 
45–51 of this manual. Exceptions are books of the Bible and other common abbreviations (such 
as OT or NT) which will be readily understood by future readers. This list must conform to the 
approved list, except where there has been a need to formulate additional abbreviations. A more 
extensive list can be found in the The SBL Handbook of Style, edited by Patrick H. Alexander et 
al. (Hendrickson, 1999). See the discussion below on page 16 of this manual.  

 

Other front matter. Do not include a dedication page, preface, or acknowledgements. 
 

Body of text (See sample pages G–M).   
 

Normal classroom papers. The title of the paper is the section heading for the body of the text. 
Place the title on the first page of text, two inches from the top edge of the page. The title should 
appear exactly as it does on the title page, except it should be single-spaced if more than one line 
is required. Leave two blank single-spaced lines between the title and the first line of text.  

 

Seminary papers must be hierarchically organized under a specific protocol. This manual allows 
up to five levels: major headings and fours subheadings. All headings are preceded by two blank 

single-spaced lines and followed by one blank single-spaced line. Major headings and the first 
two subheadings are centered and use headline capitalization style, that is, capitalize the initial 
letter of the first and last words and of all words except articles, prepositions of four letters or 
fewer, and coordinate conjunctions. Major headings appear in bold font, first level subheadings 
in italics, and second level subheadings in Roman font. Centered headings and subheadings 
exceeding five inches are subdivided into two single-spaced lines arranged in an inverted 
pyramid. Third and fourth level subheadings appear on the left margin and are capitalized in 
sentence capitalization style. Third level subheadings appear in italics, fourth level headings in 
Roman font. If all five heading levels are not used, several of them may be selected as long as 
they are used in descending order. It is not permissible to have two headings immediately 
following each other without some intervening text (except the introduction may directly follow 
the title). Also, a new section should not begin at the bottom of a page unless there is room for at 
least one line of text. 
 

The text of the body is normally double-spaced. However, a single-spaced block quotation is to 
be used for quotations that are at least four full lines in length and contain more than one 

sentence (if the quotation is more than four lines, but not more than one sentence, it should not 
appear in block format). An exception to this rule is made for the discussion of specific Scripture 
texts, where the writer is encouraged to block a smaller section of a text for discussion, 
immediately after a section heading, for the ready reference of the reader (i.e., the reader should 
not have to open additional resources in order to follow the discussion of the paper). Block 
quotations are indented on the left only, ¼ inch from the left margin (normal paragraphs are 
indented ½ inch). The right margin of block quotations should be the same as for the rest of the 
text (i.e., no indentation or right justification, and a margin of one inch to the edge of the paper). 
Block quotations are not set in quotation marks. Block quotations should never be preceded by a 
period but should have the same punctuation as if they were not block quotations. See examples 
on sample pages J, K, and M.  
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Th.M. theses. The body of the Th.M. thesis is formatted exactly like normal classroom papers 
with the following exception. Theses are organized in chapters, each chapter representing a 
separate section of the paper. As in all sections, the first page of each chapter must have the page 
number centered at the bottom of the page and a section header centered in ALL CAPS two 
inches from the top edge of the page. The section header includes the word CHAPTER, a chapter 
number in uppercase Roman numerals, and a chapter title in uppercase letters: 

 

CHAPTER IV 
 

THE DISCOVERY OF THE DEAD SEA SCROLLS 
 

In Th.M. theses the thesis title does not appear on the first page of text. Chapter titles take the 
place of major headings in the hierarchy of headings of the Th.M. thesis, leaving four subheading 
levels for each chapter. Subheadings appear exactly as they do in classroom papers: first and 

second level subheadings centered in headline capitalization style, first level subheadings in 
italics and second level subheadings in Roman font; third and fourth level subheadings on the 
left margin in sentence capitalization style, third level subheadings in italics and fourth level 
headings in Roman font. 

 
 

PART 5: PUNCTUATION, SPELLING, CAPITALIZATION,  

NUMBERS, AND ABBREVIATIONS 
 

Spelling and punctuation. “Model your spelling on American usage and be consistent, except in 
quotations, where you should usually follow the original spelling exactly” (Turabian, p. 283)). It 
is the responsibility of the student to employ grammar and punctuation in strict conformity to 
proper, formal academic usage. Pay particular attention to frequently neglected rules regarding 
the use of commas, plurals, and possessives found in chapter 21 of Turabian. Proper use of 
diacritical marks is also expected (see the Formatting Your Paper page that follows this section).  
 

Spacing and punctuation. Proportionally spaced fonts call for a spacing protocol different from 
typewritten, monospaced fonts. The following are some important differences the writer must 
observe when using proportionally spaced fonts: 

 

• Leave only one space after terminal punctuation (periods, question marks, exclamation 
marks, quotation marks and superscripted footnote references). 

• Leave no spaces before or after dashes or hyphens (see below). 

• Leave no spaces before, in between, or after the dots of an ellipsis (see below). 
 

A space follows all commas without exception. However, periods and colons lack a succeeding 
space: 

 

• within Scripture references (e.g., Rom 3:10–12). 

• between volume and page numbers (e.g., 2:136). Note, however, that there is a space if 
there is an intervening parenthesis (e.g., DBSJ 6 [2001]: 84). 

• in classical references (e.g., Pliny Natural History 2.1.9). See Turabian 19.5.1. 
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• Between hours and minutes (e.g., 4:30 P.M.) 

• in abbreviations of academic degrees (e.g., Ph.D.), and certain scholarly Latin 
abbreviations (see below, pp. 16–17). Note, however, that a space is left after periods 
following initials in a name (e.g., T. S. Eliot), and that two-letter state abbreviations and 
initials representing organizations (e.g., YMCA, GARBC) receive no period. 

 

Use non-breaking or “sticky” spaces to prevent line breaks in Scripture references (e.g., 2 
Corinthians).  
 

Punctuation and quotations. Quotations never simply appear unannounced in the text, but are 
always introduced. Quotations are introduced in three ways: 

• Quotations may appear without punctuation or capitalization as part of the flow of the 
sentence: 

 Paul informs us that we can “know that in all things God works for the good of those 
who love him” (Rom 8:28).  

• Quotations may be introduced informally (i.e., with the quotation functioning as the 
necessary object of an introductory verb) with an attendant comma. In this scenario the 
first word of the quotation is capitalized even if that word is not capitalized in the 
original: 

Paul says, “We know that in all things God works for the good of those who love 
him” (Rom 8:28). 

• Quotations may be introduced formally (i.e., with the quotation functioning as an 
identification or example that validates an introductory and usually independent clause) 
with an attendant colon. In this scenario the first word of the quotation is likewise 
capitalized: 

 In his epistles Paul expresses complete confidence in divine providence: “We know 
that in all things God works for the good of those who love him” (Rom 8:28). 

 Note: It is not necessary to include introductory conjunctions in order to maintain fidelity to 
the text of Scripture. E.g., it is not necessary to quote Romans 8:28 as “And we know that in 
all things God works for the good of those who love him,” unless, of course, attention is 
being drawn to the conjunctive element in the sentence. 

When closing a quotation, place commas and periods inside closing quotation marks but 
semicolons and colons outside closing quotation marks. Question marks and exclamation points 
precede quotation marks if they are part of the quoted material but follow if they pertain to the 
entire sentence of which the quoted material is a part. This is considered proper “American” style. 
Some British and earlier American materials do not follow this pattern. In quoting such sources it 
is permissible either to change this matter of punctuation to conform to modern American style, 
or to copy the style of the original, as long as one consistently employs either pattern. 

Always use “smart” quotation marks and apostrophes (“,”,’), not straight, or "dumb" ones (",'). 
This is a particular problem when importing electronic data directly into the term paper. 
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Hyphens and dashes. Pay careful attention to the proper use of hyphens and dashes. 

• A hyphen (-) is used only in hyphenated words or to designate line breaks. Division of 
normally non-hyphenated words at the end of a line is discouraged. If word divisions are 
used, follow the rules in Turabian 3:35–53 explicitly. 

• An en dash (−) with no preceding or succeeding spaces is used to indicate duration (e.g., 

January–March; pp. 10–20; Phil 2:5−11; 1994−98) and to produce compound words in 

which one of the terms employed is a hyphenated word (e.g., Neo-Babylonic−Persian 
conflict; Mid–Seventieth-Week Rapture).  

• An em dash (—) with no preceding or succeeding spaces is the equivalent of a 
typewritten double hyphen, and is used to signal an abrupt syntactical shift in a 
sentence—one for which a comma is too weak, but a period is unnecessary.  

Ellipses and Quotations. Contrary to Turabian and the SBL Handbook, this manual calls for the 
use of the ellipsis function-key offered in Microsoft Word and most other word processing 
programs. When the ellipsis is inserted without any adjoining punctuation, it appears with no 
spaces before or after. Whenever an ellipsis appears in connection with a period, a single space 
appears after the four dots, and a complete sentence must ensue. In the case of other punctuation 
(commas, semi-colons, colons, etc.) the placement of the punctuation relative to the ellipsis is 
determined by the relationship of the punctuation to the omitted material. For example,  

• An ellipsis may stand for omitted material in the middle…of a sentence. 

• An ellipsis may stand for omitted material that includes the end of the sentence, the 
beginning of another sentence, or both…. In this case, four dots and a space appear, and 
the ensuing material must be a complete sentence. 

• An ellipsis may occur with a punctuation mark other than a period, in which case it may 
appear with the punctuation mark before the ellipsis,…or after the ellipsis…, with the 
determining factor being the relationship of the omitted material to the punctuation mark. 

Ellipses are used only within a proximate context (i.e., an ellipsis cannot stand for multiple 
paragraphs or pages of omitted material). Ellipses are never used to open a quotation, even when 
the quoted material is drawn from the middle of a sentence in the original source. 

Parentheses and brackets. Parentheses are used to enclose minor explanatory and interruptive 
elements in a sentence (e.g., i.e., etc.) and also to enclose Scripture references. Final punctuation 
normally follows parentheses, except in rare instances when a complete sentence is parenthetical. 
Parentheses also function as the only acceptable way to enumerate a list within a paragraph: 
(1) enumerated point one and (2) enumerated point two. Note that a non-breaking (“sticky”) 
space should be used to prevent an enumeration from standing alone at the end of a line. 
Contrary to the usage in this manual, bulleted points are not to be used. 
 

Brackets are used to “enclose interpolations [e.g., explanatory remarks or the Latin word sic] in a 
quotation” (Turabian 3.99). Use [sic] to mark factual errors and misspellings and not for archaic 
language, alternate spellings, or poor grammar and punctuation. Note that the word sic is 
italicized, but not the brackets themselves. 
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Since brackets are also used to enclose a second layer of parenthetical material within 
parentheses, both parentheses and brackets commonly appear together in content footnotes. This 
is a proper and acceptable practice. Note the following: 

Incorrect: 
1F. F. Bruce, The Book of the Acts, 2nd ed., New International Commentary on the New 

Testament (Grand Rapids: Eerdmans, 1988), pp. 165–69, states correctly that this final use of the 
title in the NT is full of meaning. In view of this observation,… 

 

Incorrect: 
1F. F. Bruce states correctly that this final use of the title in the NT is full of meaning. The 

Book of the Acts, 2nd ed., New International Commentary on the New Testament (Grand Rapids: 
Eerdmans, 1988), pp. 165–69. In view of this observation,… 

 

Correct 
1F. F. Bruce (The Book of the Acts, 2nd ed., New International Commentary on the New 

Testament [Grand Rapids: Eerdmans, 1988], pp. 165–69) states correctly that this final use of the 
title in the NT is full of meaning. In view of this observation,… 

 

Better 
1F. F. Bruce states correctly that this final use of the title in the NT is full of meaning 

(The Book of the Acts, 2nd ed., New International Commentary on the New Testament [Grand 
Rapids: Eerdmans, 1988], pp. 165–69). In view of this observation,… 

 

Capitalization. Use lower case pronouns when referring to persons of the Trinity (as in the KJV 
and NIV). For the capitalization of commonly used religious terms, see pages 52–60 of this 
manual. 

 

Use of numbers in text. Excepting circumstances when cumbersome series of numbers are used, 
seminary papers should use non-scientific enumeration. To use this convention “spell out 
numbers from one through one hundred. If the number has two words, use a hyphen (fifty-five). 
Also spell out round numbers followed by hundred, thousand, hundred thousand, million, and so 
on. For all other numbers, use Arabic numerals” (Turabian 23.1.1). The same rule applies to 
ordinals. When writing ordinals, use the following non-superscripted suffixes: 121st, 122nd, 
123rd, and so on. Numbers greater than one thousand receive a comma, except in years, page 
numbers, and addresses. Numbers are properly rendered plural with s not ’s (Incorrect: 1960’s; 
Correct: 1960s).  
 
Use numerals when referring to dates and time (8:30 A.M., the year A.D. 1519), page numbers, 
Scripture references, and parts of written works (Pliny Natural History 2.1.9). Note that Roman 
numerals are not used to reference volumes, parts, and chapters of printed works, but are used to 
reference popes, kings, or different generations of family members with the same name (e.g., 
Bob Jones III or Henry VIII).  
 
Both the American style of writing dates (December 3, 1971) and the British style (3 December 
1971) are acceptable, but use one style consistently. Never begin a sentence with a numeral. 
 

For numerical sequences follow the table in Turabian 23.2.4: 
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First Number Second Number Examples 
1–99 Use all digits 3–10, 71–72, 96–117 

100 or multiples of 100 Use all digits 100–104, 1100–1113 

101 through 109, 201 through 209, etc. Use changed part only 101–8, 1103–4 

 
 

110 through 199, 210 through 299, etc. 

Use two or more digits as 
needed 

245–48, 498–532, 1929–94 
 

But if three digits change in a 
four digit number, use all four 

1894–1986, 2787–2816 

 

Abbreviations. Common abbreviations such as academic degrees, A.M. and P.M., B.C. and A.D., 
OT, NT, LXX, etc., may be used without explanation in the text or notes of seminary papers. 
Scholarly abbreviations such as those listed on pages 19–20 of this manual may be used without 
explanation in footnotes and parenthetical remarks only. Works found in the approved list of 
abbreviations appended to this manual may be abbreviated in the all footnotes (including the 
first) without explanation. If a work cited numerous times in a paper is not found in the list of 
approved abbreviations, the writer may formulate an abbreviation in the first full reference, 
borrowing, if possible, from authoritative lists such as the SBL Handbook of Style, pp. 89–152, or 
the “Journal of the Evangelical Theological Society Instructions for Contributors,” JETS 44 
(2001): 153–77. For example: 

 
1The New International Dictionary of the Christian Church, rev. ed., s.v. “Didache, The,” by R. 

E. Nixon, p. 297 [hereafter cited as NIDCC]. 
 
2NIDCC, rev. ed., s.v. “Euthalius,” by D. J. Williams, p. 357. 
 
3A. T. Robertson, A Grammar of the Greek New Testament in the Light of Historical Research, 

4th ed. (Nashville: Broadman, 1934), p. 917 [hereafter cited as RG]. 
 
4RG, p. 918. 
 

Do not use abbreviations of names or titles in the bibliography. 
 

Abbreviate the names of the books of the Bible when used parenthetically, but never abbreviate 
in the text. The abbreviations should conform to the list of abbreviations on page 42 of this 
manual. Bible quotations should not be footnoted. Instead, where the reference is not included in 
the discussion, it should follow the quotation in parentheses (Gen 1:1). This reference for 
documentation is a part of the sentence and should not be preceded by a period. A colon should 
be used between the chapter and verse divisions of a biblical reference. Note that, contrary to 
Turabian, no period is used after the book abbreviation. Commas are used between several 
references to the same level, a semicolon between references to different levels, and an en-dash 
between continued numbers: 

 

1 Thess 4:4, 8 1 Thess 4:4; 5:3 1 Thess 4:4–6 
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Formatting Your Paper in Microsoft Word XP/2003: How to Do It 
 

 

Tabs 
 

To align decimal points for chapter titles in a 
table of contents: 

Click on the Format drop-down menu. 
Choose Tabs. 
Under Tab Stop Position select a 

distance that will accommodate the 
physically longest Roman numeral 
you will use (0.2” will accommodate 
I.–VI.; 0.3” up to XVI.) 

Under Alignment select Decimal. 

Click Set. 
Click OK. 

To create a right tab aligning page numbers 
in a table of contents: 

Click on the Format drop-down menu. 
Choose Tabs. 

 Under Tab Stop Position select 6” (the 
right margin for a Th.M. thesis). 

 Under Alignment select Right. 
 Under Leader select 2...... 

Click Set. 
Click OK. 

 

Note: The same results can be achieved 
using the Ruler feature. To use the ruler, 
click on the View drop-down menu and 
select Ruler. 

 

Autoformatting Options 
 

Click on the Tools drop-down menu. 
Choose AutoCorrect. 
Select the AutoFormat As You Type tab. 
Under “Replace”: 

check the box Straight Quotes with 

Smart Quotes. 
check the box Fractions (1/2) with 

fraction character (½). 

uncheck the box Ordinals (1st) with 

superscript. 
uncheck the box Internet and network 

paths with hyperlinks. 
Click OK. 

 

Note: to make corrections for fractions and 
quotation marks after the fact, follow this 
procedure, then use the find and replace 
feature to make the corrections: 
 

Click on the Edit drop-down menu. 
Choose Replace. 
Key in a quotation mark, apostrophe, or 

fraction in both the find what and 
replace with text boxes. 

Click Replace All. 
Click OK. 
 

(Word will overwrite all the incorrect 
symbols with correctly formatted symbols.)  
 

Undoing incorrectly formatted ordinals and 
hyperlinks must be accomplished manually, 
one at a time. 

 

Common Diacritical Marks 
 

Crtl+ '    followed by a vowel →  é 

Crtl+ `   followed by a vowel  → è 

Crtl+ ~  followed by a consonant  → ñ 

Crtl+ ,   followed by a consonant  → ç 

Crtl+ /   followed by a vowel  → ø 

Crtl+ :   followed by a vowel  →   ö 

Ctrl+ ^   followed by a vowel → â 

Ctrl+ @ followed by a vowel → å 

Ctrl+ &  followed by “a” or “o” → æ or œ 
 

Dashes 
 

Ctrl+ - (numerical keypad)  → en dash 

Alt+Ctrl+ - (numerical keypad)  → em dash 
 

Non-breaking Space 
 

Ctrl+Shift+Space  →  non-breaking space. 
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Formatting Your Paper in Microsoft Word 2007: How to Do It 

 
Tabs 

 

To align decimal points for chapter titles in a 
table of contents (Th.M. thesis): 

Click on the Page Layout tab. 
Open the Paragraph dialog box launcher. 
Select the Indents and Spacing tab. 
Click on the Tabs box.* 
Under Tab Stop Position select a distance 

that will accommodate the physically 
longest Roman numeral you will use 
(0.2” will accommodate I.–VI.; 0.3” up 
to XVI.) 

Under Alignment select Decimal. 

Click Set. 
Click OK. 

To create a right tab aligning page numbers in a 
table of contents: 

Click on the Page Layout tab. 
Open the Paragraph dialog box launcher. 
Select the Indents and Spacing tab. 
Click on the Tabs box. 

 Under Tab Stop Position select 6” (the right 
margin for a Th.M. thesis). 

 Under Alignment select Right. 
 Under Leader select 2...... 

Click Set. 
Click OK. 

 

*The tabs settings may be accessed more quickly 

by double-clicking anywhere on the ruler. To use 

the ruler, click on the View tab, find the 

Show/Hide box, and check the box for Ruler. 

 

Autoformatting Options 

Click on the Microsoft Office button  
Click on Word Options. 
Click on Proofing. 
Click on Autocorrect Options. 
Select the AutoFormat As You Type tab. 
Under Replace: 

check the box Straight Quotes with Smart 

Quotes. 
check the box Fractions (1/2) with fraction 

character (½). 

uncheck the box Ordinals (1st) with 

superscript. 

 

uncheck the box Internet and network 

paths with hyperlinks. 
Click OK. 
 
Note: to make corrections for fractions, 
apostrophes, and quotation marks after the fact, 
follow this procedure, then use the find/replace 
feature to make the corrections: 
 

Click on the Home drop-down menu. 
In the Editing box click on Replace. 
Key in a fraction, apostrophe, or quotation 

mark in both the find what and replace 

with text boxes. 
Click Replace All, a command that orders 

Word to overwrite all the incorrect 
symbols with corrected ones. 

Click OK. 
 

Undoing incorrectly formatted ordinals and 
hyperlinks must be accomplished manually, 
one at a time, so be careful to change the 
autocorrect options before starting a paper. 

 

Crafting Common Diacritical Marks 
 

Crtl  '    followed by a vowel →  é 

Crtl  `    followed by a vowel  → è 

Crtl  ~   followed by a consonant  → ñ 

Crtl  ,   followed by a consonant  → ç 

Crtl  /   followed by a vowel  → ø 

Crtl  :   followed by a vowel  →   ö 

Ctrl  ^   followed by a vowel → â 

Ctrl  @  followed by a vowel → å 

Ctrl  &   followed by “a” or “o” → æ or œ 
 

Dashes 
 

Ctrl/-  (on numerical keypad)  → en dash 

Alt/Ctrl/-  (on numerical keypad) → em dash 
 

Non-breaking, “Sticky” Space 
 

Ctrl/Shift/Space  →     non-breaking space 
 

Ellipses 
 

Ctrl/Alt/.  (on standard keyboard) → ellipsis 
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PART 6: FOOTNOTE AND BIBLIOGRAPHIC ENTRIES 

The instructions in this section give guidelines for citing materials in research papers. These 
instructions are not exhaustive, but cover most types of works and note modifications from 
Turabian. If these instructions do not address a specific citation issue, consult Turabian. If 
Turabian does not address the issue, consult The Chicago Manual of Style (15th ed.). 

Make reference entries as complete as possible. References are designed to point the reader to 
exact sources, so diligence should be exercised in this matter. If bibliographic data is not readily 
accessible in the standard locations yet can be definitely established elsewhere, it should be 
included, in brackets, in the entry. The detail involved in crafting footnotes is sometimes 
onerous; however, as Turabian notes, “If you do not get these small matters right, many of your 
readers will question whether they can trust you on the big ones” (Turabian 15.2.2). 

Appearance of footnotes. All research papers and theses submitted to Detroit Baptist Seminary 
must use footnotes, not endnotes or parenthetical references. There are four types of footnotes 
that appear in scholarly writing, and students should learn to use all four: (1) citation footnotes 
that identify an authority referenced, (2) cross references within the paper, (3) content footnotes 
that make incidental comments that fill out the discussion but which would interrupt the flow of 
the argument if included within the text, and (4) acknowledgments. 

Footnotes appear in the same font style used in the rest of the paper, but should appear in 10-
point font. Footnotes are separated from the text by a two-inch separator line and a single space. 
Each note is indented ½ inch, begins with a superscripted Arabic note number, and commences 
immediately after the note number with no intervening space. Footnotes are single-spaced with a 
single blank line separating each note. The component parts of footnotes are separated with 
commas or parentheses. 

Footnote numbering runs continuously throughout the entire paper or thesis. Do not begin each 
page or each chapter with footnote “1.” Footnotes must begin on the same page on which the 
reference number appears in the text, but may continue on the next page. When a note continues 
to the next page, however, make sure that the break is in mid-sentence so that the reader does not 
mistakenly overlook the material on the next page. Do not use footnotes in section headings. 
Footnotes normally fall at the close of sentences or clauses, not after words or phrases within a 
single thought. Never place two footnotes together at the same point in your paper5, 6 and avoid 
clusters7 of8 footnotes.9 Instead, combine thoughts into a single footnote.  

Abbreviations. Unlike the text of the research paper, footnotes make liberal use of accepted 
scholarly abbreviations when possible. The following is a list of common Latin terms and 
abbreviations that are to be used in footnotes:  

b.  → born 

ca. → circa = approximately 

cf. → confer = compare (do not confuse with 

“see”) 

chap. → chapter 

col. → column 

comp. → compiler; complied by 

contra → against; as opposed to 

d. → died 

ed. → editor; edition; edited by 

e.g. → exempli gratia = for example (do not 

confuse with i.e.) 

esp. →   especially 

et al. → et alii = and others (as individuals) 

  et alia = and others (as things) 

etc. → et cetera = and so forth  
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exp. → expanded 

ibid. → ibidem = in the same place (source) 

idem → the same (usu. of an author) 

i.e. → id est = that is (do not confuse with e.g.) 

infra → below (within one’s own work) 

in re → in the matter of; concerning 

l./ll. → line(s) 

n./nn. → note(s) 

n.b./NB → nota bene = note well 

n.d. → no date 

no. → number 

n.p. → no place; no publisher 

n.s. → new series 

o.s. → old series 

p./pp. → page(s) 

par. → paragraph 

per se → taken alone 

pt. → part 

q.v. → quod vide = which see 

qua → in the capacity of 

rev. → revised 

sec. → section 

sic → lit. “thus”—used to indicate an error 

that is reproduced as in the original 

supp. → supplement 

supra  → above (within one’s own work) 

s.v./s.vv. → sub verbo = under the word (used with 
dictionary and encyclopedia entries) 

trans. → translator; translated by 

v./vv. → verse(s) 

vice versa→ the order being reversed 

vis-à-vis → lit. “face to face” = as compared with 

viz. → videlicet = namely 

vol. → volume 

vs. → versus (use v. only in legal contexts 
so as not to confuse with “verse.”)

 
In footnotes use the approved abbreviations for the books of the Bible, periodicals, reference 
works, and serials found on pages 42–51 of this manual. Works found in the approved list of 
abbreviations may be abbreviated in the first footnote. For works not found in the list of 
approved abbreviations, the writer may formulate an abbreviation in the first full reference: 

 
1
The New International Dictionary of the Christian Church, rev. ed., s.v. “Didache, The,” 

by R. E. Nixon, p. 297 [hereafter cited as NIDCC]. 
 
2
NIDCC, rev. ed., s.v. “Euthalius,” by D. J. Williams, p. 357. 

 
3A. T. Robertson, A Grammar of the Greek New Testament in the Light of Historical 

Research, 4th ed. (Nashville: Broadman, 1934), p. 917 [hereafter cited as RG]. 
 
4RG, p. 918. 
 

Subsequent and shortened references. After a work has been cited in full, it is not necessary to 
make a complete citation for subsequent references. While abbreviations such as op. cit., and loc. 

cit. have fallen into disfavor, the following truncations are acceptable and expected: 
 

• When reference is made to the same work as in the immediately preceding reference, use 
ibid. to replace the author’s name, title, and as much of the succeeding material 
(including page numbers) as is identical to the previous note. Ibid. is not italicized, 
always appears with a period (as an abbreviation for ibidem), and is capitalized when it 
begins a note. Note that ibid. refers to the exact work as in the previous note, not just the 
same author. Never use ibid. after a note containing two or more references. 
 

1Charles C. Ryrie, Dispensationalism (Chicago: Moody Press, 1995), p. 155. 
 

2Ibid. [for a citation from the same page in the same source] 
 

3Ibid., p. 156. [for a citation from a different page in the same source] 
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• When reference is made to a work with the same author as the immediately preceding 
reference or within a note to a second work by the same author, use idem to replace the 
author’s name only. Like ibid., idem is not italicized and is capitalized at the beginning of 
a note. Since it is a complete word, however, it is not followed by a period. As with ibid., 
never use idem after a note containing two or more references or if authors are added to 
or omitted from the previous reference. 
 

1Charles C. Ryrie, Dispensationalism (Chicago: Moody Press, 1995), p. 155. 
 
2Idem, Basic Theology (Wheaton, IL: Victor, 1986), p. 19. 

 

but 
 

3Charles C. Ryrie and Paul E. Steele, Meant to Last (Wheaton, IL: Victor, 1986), p. 

19. 
 

• When referencing a work that has already been cited in full, but not in the immediately 

preceding note, a shortened reference should be used. For shortened references use the 
last name of the author(s), followed by a shortened title, then by pages referenced. 
Shorten the title by omitting the subtitle, initial article, and modifying words and phrases. 
Avoid one-word shortened references, except with commentaries. See the examples of 
subsequent references in the subsections below.  

 
Appearance of bibliographic entries. See sample page N. The bibliography, as defined in this 
manual, is a comprehensive list of all sources consulted with profit in the course of research. 
However, it is entitled simply “Bibliography.” The entries appear in alphabetical order in a single 
list. Do not separate the bibliography into classifications such as “Books” and “Articles” or 
“Primary Sources” and “Secondary Sources.” Note that major sacred texts such as the Bible 
(whether in English or in the original languages) or Koran are not included in the bibliography 
(Turabian 16.2.3). 
 
The first line of each bibliographic entry is flush with the left margin of the page, and all 
successive lines are indented ½ inch. The bibliography is single-spaced with a single blank line 
separating entries. Unlike footnotes, which separate component parts with commas or 
parentheses, bibliographies usually separate component parts with periods. 
 
Do not use abbreviations of names or titles in the bibliography. Spell out any abbreviations that 
follow a period in a bibliographic entry (e.g., “Edited by,” “Translated by,” “Revised ed.”) with 
the exception of “s.v.” in separately signed articles of standard reference works. In successive 
entries for works by the same author, however, the author’s name in subsequent entries may be 
replaced with a ½-inch line. Do not use this line if authors are added or omitted in subsequent 
references. 

 

Ryrie, Charles C. Basic Theology. Wheaton, IL: Victor, 1986. 
 

_______. Dispensationalism. Chicago: Moody Press, 1995. 
 

but 
 

 Ryrie, Charles C., and Paul E. Steele. Meant to Last. Wheaton, IL: Victor, 1986. 
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Books 
 

The following is a list of component parts of a book reference. The sequence of these parts 
should be maintained at all times, even though every component will not appear in a given note. 
(For example, a book may have no editor and belong to no series.) In this case, simply skip these 
parts and go on to the next. But do not tamper with this sequence. 
 

• Name of author(s) 

• Title and pertinent subtitle 

• Name of editor, compiler, or translator  

• Number or name of the edition if other than the first 

• Name of series in which book appears, including volume or number in the series 

• Facts of publication, including (1) the place of publication, (2) the name of the 

publisher or publishing agency, and (3) the date of publication 

• Page number(s) of a specific citation (footnote entries only) 
 

Name of author(s). In footnotes, authors’ names are given in normal order (First M. Last). The 
names should appear as they do on the title page, but full middle names may be reduced to a 
middle initial. Do not include professional or ministerial titles (e.g., Doctor, Reverend) or 
degrees conferred. Books with two or three authors should list all the authors, but books with 
four or more authors should list the first author followed by “et al.” 
 

FN:  1D. A. Carson, Douglas J. Moo, and Leon Morris, An Introduction to the New Testament 
(Grand Rapids: Zondervan, 1992), p. 12. 

 

  2Carson, Moo, and Morris, Introduction to the New Testament, p. 276. 
 

In bibliographies, the first author’s name is given in inverse order (Last, First M.), with 
successive names in normal order (First M. Last). Unlike footnotes, bibliographies list the names 
of all authors, even when there are four or more. 
 

B: Carson, D. A., Douglas J. Moo, and Leon Morris. An Introduction to the New Testament. Grand 
Rapids: Zondervan, 1992. 

 

If a writer wishes to reference an edited book as a whole, it is acceptable to cite the editor of the 

work in the manner given above with the addition of a comma and ed(s). Usually, however, a 
writer will not reference an edited book as a whole, but an essay in the book (see below).  
 

FN:  
1 Wesley R. Willis and John R. Master, eds., Issues in Dispensationalism (Chicago: Moody 

Press, 1994). 
 

  2Willis and Master, Issues in Dispensationalism. 
 

B: Willis, Wesley R., and John R. Master, eds. Issues in Dispensationalism. Chicago: Moody Press, 
1994. 

 

If authorship or pseudonymity has been definitely attested but does not appear on the title or 
copyright page, the information should be included in brackets in references. If authorship 
cannot be attested, the entry may begin with the title. Note the following: 



 23

  1[Richard Cox], An Inquiry into Religion and the Use of Reason in Reference to It…  
 

  2John Woodmorappe [pseud.], Noah’s Ark: A Feasibility Study… 
 

  3Isaac Skillman [John Allen?], An American Alarm, or, The Bostonian Plea for the Rights, and 

Liberties, of the People…  
 

  4
A Narrative of the General Assembly in London, 1689… 

 

In cases where the author’s name is part of the title, omit the author’s name in a footnote, but 
retain it in bibliographies, despite the redundancy. 
 
FN:  1

Melanchthon on Christian Doctrine: Loci Communes 1555, trans. and ed. Clyde L. 
Manschreck. Oxford: Oxford University Press, 1965), p. 89. 

 

 but 
   

B:  Melanchthon, Philip. Melanchthon on Christian Doctrine: Loci Communes 1555. Translated and 
edited by Clyde L. Manschreck (Oxford: Oxford University Press, 1965. 

 

Title and pertinent subtitle. In both footnotes and bibliographies the title appears in italics in 
headline capitalization form. Original spelling and punctuation should be maintained from the 
title page, except that a colon may be assumed between a title and subtitle even if one does not 
appear on the title page. Do not add a comma or colon if a title or subtitle ends with terminal 
punctuation (e.g., a question mark or exclamation point). Contrary to Turabian, the subtitle of a 
book should be included in references only when the subtitle aids the reader in identifying more 
accurately the nature of the work cited.  

 

FN:
  1Peter T. O’Brien, The Epistle to the Philippians, NIGTC (Grand Rapids: Eerdmans, 1991), 

p. 213. 
 

  2O’Brien, Philippians, p. 215. 
 

B: O’Brien, Peter T. The Epistle to the Philippians. New International Greek Testament Commentary. 
Grand Rapids: Eerdmans, 1991. 

 

 [Omit the superfluous subtitle A Commentary on the Greek Text.] 
 

 but 
 

FN:  
1Homer A. Kent, The Freedom of God’s Sons: Studies in Galatians (Grand Rapids: Baker, 

1976), p. 34.  
 

  2Kent, Freedom of God’s Sons, p. 56. 
 

B: Kent, Homer A. The Freedom of God’s Sons: Studies in Galatians. Grand Rapids: Baker, 1976. 
 

 [Here the subtitle is necessary to identify this work as a commentary on Galatians.] 
 

Name of editor, compiler, or translator. In footnotes, the names of editors, compilers, or 
translators appear in normal order (First M. Last) in the order they appear on the title page, 
preceded by the appropriate abbreviations ed., comp., or trans. Note that in this case ed. is not 
plural because it stands for edited by, not editor or edition. Each phrase is set off by commas. 
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In bibliographies the names also appear in normal order, but are preceded by the full, 
unabbreviated phrases Edited by, Compiled by, or Translated by. Each phrase is set off by 
periods. 
 
FN:  1H. A. W. Meyer, Critical and Exegetical Handbook to the Gospel of Matthew, trans. Peter 

Christie, rev. and ed. Frederick Crombie and William Stewart, 6th ed. (New York: Funk and 
Wagnalls, 1884), p. 43. 

 
  2Meyer, Matthew, pp. 45–47. 
 
B: Meyer, H. A. W. Critical and Exegetical Handbook to the Gospel of Matthew. Translated by Peter 

Christie. Revised and edited by Frederick Crombie and William Stewart. 6th ed. New 
York: Funk and Wagnalls, 1884. 

 

Contrary to Turabian, the name of the author of a preface, forward, or introduction should not be 
included unless citing or specifically referencing the preface, etc., in which case cite as follows: 
 
FN:  

1Cornelius Van Til, introduction to The Inspiration and Authority of the Bible, by Benjamin 
B. Warfield, ed. Samuel G. Craig (Philadelphia: Presbyterian & Reformed, 1948), p. 56.  

 

  2Van Til, introduction to Inspiration and Authority, p. 58. 
 

B: Cornelius Van Til. Introduction to The Inspiration and Authority of the Bible, by Benjamin B. 
Warfield. Edited by Samuel G. Craig. Philadelphia: Presbyterian & Reformed, 1948. 

 

Number or name of the edition if other than the first. In both footnotes and bibliography entries 
new, revised, numbered, or named editions must be noted. (Reprint editions are also noted, but 
this information appears with the fact of publication—see below.) Abbreviations should be used 
in footnotes, but an abbreviation should be spelled out in a bibliography entry when it follows a 
period (examples 1, 4, and 5), or when it is parallel to a non-abbreviated term (e.g., enlarged in 
example 5).  
  

Footnote Bibliography 

rev. ed. Revised ed. 

2nd ed. 2nd ed. 

3rd ed., rev. and enl. 3rd ed., rev. and enl. 

rev. ed. in 1 vol. Revised ed. in 1 vol. 

rev. and enl. ed. Revised and enlarged ed. 

 
New editions may also have new editors, which should be noted: 
 

FN:  
1Kate L. Turabian, A Manual for Writers of Term Papers, Theses, and Dissertations, 6th ed., 

rev. John Grossman and Alice Bennett (Chicago: University of Chicago Press, 1996), p. 129. 
 

  2Turabian, Manual for Writers, p. 130. 
 

B: Turabian, Kate L. A Manual for Writers of Term Papers, Theses, and Dissertations. 6th ed., rev. 
John Grossman and Alice Bennett. Chicago: University of Chicago Press, 1996. 
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Name of series in which book appears, including volume or number in the series. Some 
books are published as part of a named series. These must not be confused with multivolume 
works or periodicals. A multivolume set has a single title (though individual volumes may also 
have independent titles), deals with a single subject, has a single editor or group of editors, and 
has a more or less defined number of volumes from the outset of the project. Periodicals are 
published at fixed intervals, are open-ended, generally have a broader scope of subjects, and each 
issue contains multiple signed articles. A series is an ongoing publication series with a common 
sponsor (usually a publisher, institution, or university), has an erratic publication schedule, and 
has a rather wide range of topics that appear individually as whole books. 
 

In both footnotes and bibliographies, series information appears in Roman (not italicized) font 
just before the facts of publication, and includes volume number and series editorship exactly as 
they appear on the title page. Series abbreviations may be used in footnotes, but not in 
bibliographic entries. 
 

FN:  
1Gregory A. Wills, Democratic Religion: Freedom, Authority, and Church Discipline in the 

Baptist South, 1785–1900, Religion in America Series, ed. Harry S. Stout (New York: Oxford 
University Press, 1997), p. 19.  

 

  2Wills, Democratic Religion, pp. 23–29. 
 

B: Wills, Gregory A. Democratic Religion: Freedom, Authority, and Church Discipline in the Baptist 

South, 1785–1900. Religion in America Series, ed. Harry S. Stout. New York: Oxford 
University Press, 1997. 

 

FN:  
1Darrell L. Bock, Proclamation from Prophecy and Pattern: Lucan Old Testament 

Christology, JSOTSup, no. 12 (Sheffield: JSOT, 1987), p. 45.  
 

  2Bock, Proclamation from Prophecy and Pattern, p. 47. 
 

B: Bock, Darrell L. Proclamation from Prophecy and Pattern: Lucan Old Testament Christology. 
Journal for the Society of the Old Testament Supplements, no. 12. Sheffield: JSOT, 1987. 

 

Most commentary sets do not fit into any clearly defined category. They have characteristics of 
both series and multivolume works (see below). Use the examples below to formulate references 
for commentaries. Note that names of commentary sets (e.g., NICNT, ICC, AB, TNTC) are not 
italicized. Note also that volume numbers and series editors are omitted.  
 

FN:  1A. E. Brooke, A Critical and Exegetical Commentary on the Johannine Epistles, ICC 
(Edinburgh: T. and T. Clark, 1912), p. 76.  

 

  2Brooke, Johannine Epistles, pp. 77–79. 
 

B: Brooke, A. E. A Critical and Exegetical Commentary on the Johannine Epistles. International 
Critical Commentary. Edinburgh: T. and T. Clark, 1912. 

 

FN:  1Martin Dibelius and Hans Conzelmann, The Pastoral Epistles, trans. Philip Buttolop and 
Adela Yarbo, Hermeneia (Philadelphia: Fortress, 1972), p. 46.  

   

  2Dibelius and Conzelmann, Pastoral Epistles, p. 48. 

B: Dibelius, Martin, and Hans Conzelmann. The Pastoral Epistles. Translated by Philip Buttolop and 
Adela Yarbo. Hermeneia. Philadelphia: Fortress, 1972. 
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FN:  1William L. Lane, The Gospel According to Mark, NICNT (Grand Rapids: Eerdmans, 
1974), p. 34.  

   

  2Lane, Mark, pp. 49–51. 
 

B: Lane, William L. The Gospel According to Mark. New International Commentary on the New 
Testament. Grand Rapids: Eerdmans, 1974. 

 
FN:  1Raymond E. Brown, The Gospel According to John, 2 vols., AB (Garden City, NY: 

Doubleday, 1966, 1970), 1:54.  
   

  2Brown, John, 1:64. 
 

B: Brown, Raymond E. The Gospel According to John. 2 vols. Anchor Bible. Garden City, NY: 
Doubleday, 1966, 1970. 

 
Facts of publication. The facts of publication include (1) the place of publication, (2) the names 
of the publisher or publishing agency, and (3) the date of publication. In footnotes the facts of 
publication are enclosed in parentheses with no preceding punctuation and an ensuing comma. In 

a bibliography entry parentheses are omitted and a period follows the publication information. 
 
When giving the city of publication, give the city provided on the title page. If two cities are 
given, choose the first U.S. city listed. If there is no U.S. city listed, choose the first English-
speaking city listed. If there are no English-speaking cities listed, choose the first city mentioned, 
giving the English name for a foreign city (e.g., Munich, not München). If the city is not well 
known or might otherwise be confused with another (e.g., Cambridge), include a comma and the 
two-letter postal code abbreviation with the city. In both footnotes and bibliography entries the 
place of publication is followed by a colon, a space, and then the publisher. If no city is given, 
but the city may be definitely established, include the city name in brackets. Otherwise use the 
abbreviation n.p. (no place). 
 

Normally the name of the publisher should be given in full. However, the initial “The,” the 
abbreviations “Co.,” “Inc.,” or “Ltd.,” and certain words like Press and Publishing House are 
omitted. Note, however, that university presses retain the word press. “Brothers” should be 
abbreviated as “Bros.” A listing of shortened names for select publishing firms is included on 
pages 36–37 of this manual. If no publisher is listed use the abbreviation n.p. (no publisher). If 
there is neither city nor publisher listed, a single n.p. is sufficient. 
 

The date of publication is the latest copyright date on the verso of the title page. Do not confuse 
this with the latest printing or impression date. If no date is given, but the date may be definitely 
established, include it in brackets. Otherwise use the abbreviation n.d. (no date). If a book has 
been accepted for publication but is not yet published, supply the word forthcoming. 
 
Page number (footnotes only). If a footnote refers to a book as a whole, page numbers are 
omitted. Otherwise, the specific page number(s) of the reference are listed preceded by a comma, 
a space, and p. (single page) or pp. (multiple pages). Use of f. and ff. is no longer acceptable in 
formal writing. 
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Examples: 
 

Footnote Bibliography Entry 

(New York: Oxford University Press, 1997), p. 5. New York: Oxford University Press, 1997. 

(Chicago: Moody Press, 1964), pp. 234–36. Chicago: Moody Press, 1964. 

(Winona Lake, IN: Eisenbrauns, 1999), p. 19. Winona Lake, IN: Eisenbrauns, 1999. 

(n.p.: Franklin Bros., 1836), pp. 13–16. N.p.: Franklin Bros., 1836. 

(n.p., 1741), p. 126. N.p., 1741. 

([London]: Baptist Historical Society, 1881), p. 4. [London]: Baptist Historical Society, 1881. 

(Cornhill: for the author, n.d.), pp. 192, 198. Cornhill: for the author, n.d. 

(Grand Rapids: Baker, forthcoming), p. 119. Grand Rapids: Baker, forthcoming. 
 

Reprint Editions: When an original publisher reprints a book without changes or in paperback, 
this is not considered a reprint edition by this manual. In such cases the reprint date is ignored—
the latest copyright date is the one reported. In order to be considered a reprint edition, a 
publication must be reproduced by a different publisher and/or with changes in 
formatting/pagination. In such cases, include all of the publication data for the reprint and for the 
original publication, if indicated. 
 

FN:  1George Smeaton, The Doctrine of the Holy Spirit (reprint, Edinburgh: Banner of Truth, 
1974), p. 99.  

   

  2Smeaton, Holy Spirit, p. 103. 
 

B: Smeaton, George. The Doctrine of the Holy Spirit. Reprint. Edinburgh: Banner of Truth, 1974. 
 

FN:   1D. A. Carson, Divine Sovereignty and Human Responsibility: Biblical Perspectives in 

Tension (reprint of 1981 John Knox ed., Grand Rapids: Baker, 1994), p. 59.  
 

  2Carson, Divine Sovereignty and Human Responsibility, p. 244. 
 

B: Carson, D. A. Divine Sovereignty and Human Responsibility: Biblical Perspectives in Tension. 
Reprint of 1981 John Knox ed. Grand Rapids: Baker, 1994. 

 

 

Multivolume Works 
 

See above for the difference between multivolume works, series, and periodicals. Entries for 
multivolume sets differ from entries for books in as many as three areas: (1) specific volume 
information, (2) date, and (3) page references. 
 

Multivolume works with a single author and title. Include the total number of volumes in Arabic 
numerals just before the facts of publication. If a set is incomplete use the form 3 vols. to date. 
 

Include the dates of publication for the entire set. In a two-volume work with different copyright 
dates, each date should be listed separately. In a work of three or more volumes, the dates can be 
listed separately (e.g., 1957, 1964, 1971) or a duration of dates may be indicated (e.g., 1957–71). 
If a multivolume work is incomplete, the date should be left open (e.g., 1998–). 
 

For page numbers, do not use p. or pp. Instead, indicate the page cited by using the volume 
number followed by a colon, no space, and the specific page number (2:136). 
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FN:   
1Gordon R. Lewis and Bruce A. Demarest, Integrative Theology, 3 vols. (Grand  Rapids: 

Zondervan, 1987–94), 3:146.  

  2Lewis and Demarest, Integrative Theology, 1:292. 

B: Lewis, Gordon R., and Bruce A. Demarest. Integrative Theology. 3 vols. Grand Rapids: Zondervan, 
1987–94. 

Multivolume works with a single general title and different volume titles by a single author. In 
this instance include (1) the specific volume title, followed by (2) in, then (3) the multi-volume 
title. If a single physical volume is in view, use the date of that volume and not of the entire set. 
Since a single volume is in view, revert to page numbers preceded by p. or pp. 

FN:  
1Benjamin B. Warfield, Revelation and Inspiration, in The Works of Benjamin B. Warfield 

(New York: Oxford University Press, 1932), p. 319.  

  2Warfield, Revelation and Inspiration, p. 412. 

B: Warfield, Benjamin B. Revelation and Inspiration. In The Works of Benjamin B. Warfield. New 
York: Oxford University Press, 1932. 

If, however, more that one physical volume is in view, use the following: 

FN:  
1Carl F. H. Henry, The God Who Speaks and Shows, 4 vols., in God, Revelation, and 

Authority (Waco, TX: Word, 1976–79), 2:115.  

  2Henry, God Who Speaks and Shows, 3:176. 

B: Henry, Carl F. H. The God Who Speaks and Shows. 4 vols. In God, Revelation, and Authority. 
Waco, TX: Word, 1976–79. 

FN:  1C. F. Keil and F. Delitzsch, The Pentateuch, trans. James Martin, 3 vols. in 1, in Biblical 

Commentary on the Old Testament (reprint, Grand Rapids: Eerdmans, 1975), 2:67.  

  2Keil and Delitszch, Pentateuch, 3:119. 

B: Keil, C. F., and F. Delitzsch. The Pentateuch. Translated by James Martin. 3 vols. in 1. In Biblical 

Commentary on the Old Testament. Reprint. Grand Rapids: Eerdmans, 1975. 

Multivolume works with a general title and editor and individually authored or edited volumes 

each with its own title. Follow the protocol above, but include specific editing information as 
follows: 
 
FN:  

1Jonathan Edwards, Freedom of the Will, ed. Paul Ramsey, in The Works of Jonathan 

Edwards, ed. Perry Miller (New Haven, CT: Yale University Press, 1957), p. 145.   
   
  2Edwards, Freedom of the Will, p. 100–4. 
 
B: Edwards, Jonathan. Freedom of the Will. Edited by Paul Ramsey. In The Works of Jonathan 

Edwards, ed. Perry Miller. New Haven, CT: Yale University Press, 1957. 
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Journal Articles 
 

The following is a list of component parts of a journal article reference. The sequence of these 
parts should be maintained at all times. 

 

• Name of author(s) 

• Title of article 

• Title of journal 

• Volume number 

• Publication date 

• Page number(s) 
 

Name of author(s). For both footnotes and bibliographic entries, cite authors of journal articles in 
the same way as authors of books. 

 

Title of article. For both footnotes and bibliographic entries, enclose the title in quotation marks 
in headline capitalization style. Do not use italics for article titles. 
 

Title of Journal. For both footnotes and bibliographic entries, the journal title should be italicized 
and should appear in headline capitalization style. Do not use quotation marks for journal titles. 
For footnotes, use abbreviations for journal titles from the approved list on pages 45–51 of this 
manual. If a specific journal title does not appear on this list, an abbreviation may be formulated 
in the manner described on page 17 of this manual. For bibliographic entries, spell out journal 
titles in full. 
 

[Note: for the Th.M. thesis all abbreviations used must appear in the List of Abbreviations.] 
 

Volume number. Immediately following the journal title with no intervening punctuation the 
volume or issue number should appear in Arabic numerals. When a journal has both a volume and 
issue number, it is necessary to include only the volume number. If a journal has only an issue 
number, however, use the issue number preceded by the abbreviation no. 
 

Publication Date. The date of publication follows the volume number and is enclosed in 
parentheses. Contrary to Turabian, always include the month or season as it appears on the journal 
title page or issue cover. 

Page numbers. In footnotes, the specific page(s) referenced follows the publication date and a 
colon. In initial entries, the abbreviations p. and pp. are not used. Note, however, the change in 
subsequent references. In bibliographic entries inclusive pages for the whole article follow the 
publication date. 
 

FN:  1John H. Walton, “Deuteronomy: An Exposition of the Spirit of the Law,” GTJ 8 (Fall 
1987): 213. 

 

  2Walton, “Deuteronomy,” p. 215. 
 

B: Walton, John H. “Deuteronomy: An Exposition of the Spirit of the Law.” Grace Theological  

   Journal 8 (Fall 1987): 213–25. 
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FN:   
1William W. Combs, “The Transmission-History of the Septuagint,” BSac 146 (July–

September 1989): 256. 
 

   
2Combs, “Transmission-History of the Septuagint,” pp. 257–59. 

 

B: Combs, William W. “The Transmission-History of the Septuagint.” Bibliotheca Sacra 146 (July–
September 1989): 255–69. 

 

FN:   
1J. K. Elliott, “Manuscripts, the Codex, and the Canon,” JSNT no. 63 (September 1996): 

105. 
 

   2Elliott, “Manuscripts, Codex, and Canon,” p. 110. 
 

B: Elliott, J. K. “Manuscripts, the Codex and the Canon.” Journal for the Study of the New Testament 
no. 63 (September 1996): 105–23. 

 
 

Component Part of a Book or Volume 
 

Volumes of collected essays or short books present new elements for the writer. Citation of these 
component parts combines elements from the citation styles for both books and periodicals. Note 
the following sequence: (1) the author of the component essay or book, followed by (2) the essay 
title enclosed in quotation marks or book title in italics). This is followed by (3) the word in and 
the title of the collected work, and (4) the name of the editor (if applicable). The rest of the 
reference (series titles, publication data, page numbers) follows exactly like a book. Note the 
following examples: 
 

Essay in an edited collection of essays: 

 
FN:  

1Roger Nicole, “Some Comments on Hebrews 6:4–6 and the Doctrine of the Perseverance 
of God with the Saints,” in Current Issues in Biblical and Patristic Interpretation, ed. Gerald F. 
Hawthorne (Grand Rapids: Eerdmans, 1975), p. 341. 

 

  2Nicole, “Comments on Hebrews 6:4–6,” p. 344. 
 

B: Nicole, Roger. “Some Comments on Hebrews 6:4–6 and the Doctrine of the Perseverance of God 
with the Saints.” In Current Issues in Biblical and Patristic Interpretation. Edited by 
Gerald F. Hawthorne. Grand Rapids: Eerdmans, 1975. 

Essay in a non-edited collection of essays: 

FN:  
1Paul D. Feinberg, “The Case for the Pretribulation Rapture Position,” in Three Views on the 

Rapture: Pre-, Mid-, or Post-Tribulational? Counterpoints (Grand Rapids: Zondervan, 1996), p. 69. 

  2Feinberg, “Case for the Pretribulation Rapture,” p. 344. 

B: Feinberg, Paul D. “The Case for the Pretribulation Rapture Position.” In Three Views on the 

Rapture: Pre-, Mid-, or Post-Tribulational? Counterpoints. Grand Rapids: Zondervan, 
1996. 
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Essay in a multi-volume collection of essays: 

FN:  
1John Murray, “The Atonement and the Free Offer of the Gospel,” in The Collected 

Writings of John Murray, 4 vols. (Carlisle, PA: Banner of Truth, 1976–1982), 1:84. 

  2Murray, “Atonement and the Free Offer,” in Collected Writings of John Murray, 1:85. 

B: Murray, John. “The Atonement and the Free Offer of the Gospel.” In The Collected Writings of 

John Murray. 4 vols. Carlisle, PA: Banner of Truth, 1976–1982. 

Alternatively, when it is preferable to note the exact date of an essay in a multi-volume collection, cite as 
follows:  

FN:  
1D. A. Carson, “Matthew,” in vol. 8 of The Expositor’s Bible Commentary, ed. Frank E. 

Gaebelein (Grand Rapids: Zondervan, 1984), p. 45. 

  2Carson, “Matthew,” p. 78. 

B: Carson, D. A. “Matthew.” In vol. 8 of The Expositor’s Bible Commentary. Edited by Frank E. 
Gaebelein. Grand Rapids: Zondervan, 1984. 

Originally full-length book bound together with other materials in a single volume: 

FN:  
1Jonathan Edwards, The Life and Diary of the Rev. David Brainerd, in The Works of 

Jonathan Edwards, 2 vols., rev. and corr. Edward Hickman (reprint, Carlisle, PA: Banner of Truth, 
1974), 2:359. 

2Edwards, Life and Diary of Brainerd, p. 265. 

B: Edwards, Jonathan. The Life and Diary of the Rev. David Brainerd. In The Works of Jonathan 

Edwards. 2 vols. Revised and Corrected by Edward Hickman. Reprint. Carlisle, PA: 
Banner of Truth, 1974. 

 
Articles in Encyclopedias, Dictionaries, and Lexicons 

 

Unsigned Articles: If an article is unsigned, provide full citation for material cited from an 
encyclopedia, dictionary, or lexicon. Footnotes referencing works with approved abbreviations 
(pp. 45–51 of this manual) include only the abbreviation and (contra Turabian) a page number. 
The bibliography, however, should contain full bibliographic information. Note the following: 

 
FN:  1BDB, p. 182. [There is no shortened reference for this entry.] 

B: Brown, Francis, S. R. Driver, and C. A. Briggs, eds. A Hebrew and English Lexicon of the Old 

Testament. Oxford: Clarendon Press, 1968. 

FN:  1BDAG, p. 588. [There is no shortened reference for this entry.] 

B: Bauer, Walter, Frederick W. Danker, William F. Arndt, and F. Wilbur Gingrich. A Greek-English 

Lexicon of the New Testament and Other Early Christian Literature. 3rd ed. Revised and 

edited by Frederick W. Danker. Chicago: University of Chicago Press, 2000. 
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FN:  1LSJ, p. 83. [There is no shortened reference for this entry.] 

B: Liddell, Henry G. and Robert Scott, comp. A Greek-English Lexicon. Revised and augmented by 
Henry S. Jones with the assistance of Roderick McKenzie et al., with a supplement. 
Oxford: Clarendon Press, 1968. 

FN:  1William L. Holladay, A Concise Hebrew and Aramaic Lexicon of the Old Testament 
(Grand Rapids: Eerdmans, 1971), p. 74. 

  2Holladay, Hebrew and Aramaic Lexicon, p. 64. 

B: Holladay, William L. A Concise Hebrew and Aramaic Lexicon of the Old Testament. Grand Rapids: 
Eerdmans, 1971. 

FN:  1Marcus Jastrow, comp., A Dictionary of the Targumim, the Talmud Babli and Yerushalmi, 

and the Midrashic Literature, 2 vols. (reprint ed., Brooklyn: P. Shalom Publishing, 1967), 1:26. 

  2Jastrow, Dictionary of the Targumim, 2:93. 

B: Jastrow, Marcus, comp. A Dictionary of the Targumim, the Talmud Babli and Yerushalmi, and the 

Midrashic Literature. 2 vols. Reprint ed. Brooklyn: P. Shalom Publishing, 1967. 

 

Signed Articles. Signed articles in well-known reference works need not be cited in full in either 
footnotes or bibliographic entries. They must, however, include the title of the reference source, 
edition (if other than the first), the author of the article, a sub verbo notation, and a page number. 
As is normally the case, approved abbreviations are adequate in footnotes, but not in bibliography 
entries. Note the following: 

FN:  1
ISBE, rev. ed., s.v. “Authority,” by G. W. Bromiley, 1:365. 

  2
ISBE, rev. ed., s.v. “Authority,” 1:366. 

B: International Standard Bible Encyclopedia. Revised ed. S.v. “Authority,” by G. W. Bromiley. 

FN:  1
ZPEB, s.v. “Aramaic Language,” by Gleason L. Archer, 1:254. 

  2
ZPEB, s.v. “Aramaic Language,” 1:253. 

B: Zondervan Pictorial Encyclopedia of the Bible. S.v. “Aramaic Language,” by Gleason L. Archer. 

FN:  1
TDNT, s.v. “livqo",” by J. Jeremias, 4:269–70. 

  2
TDNT, s.v. “livqo",” 4:269–70. 

B: Theological Dictionary of the New Testament. S.v. “livqo",” by J. Jeremias. 

FN:  1
NIDNTT, s.v. “Baptism, Wash,” by G. R. Beasley-Murray, 1:145. 

  2
NIDNTT, s.v. “Baptism, Wash,” 1:145. 

B: New International Dictionary of New Testament Theology. S.v. “Baptism, Wash,” by G. R. 
Beasley-Murray. 
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FN:  1
Encyclopedia of Millennialism and Millennial Movements, s.v. “Dispensationalism,” by 

Robert K. Whalen, p. 126. 

  2
Encyclopedia of Millennialism and Millennial Movements, s.v. “Dispensationalism,” p. 127. 

B: Encyclopedia of Millennialism and Millennial Movements. S.v. “Dispensationalism,” by Robert K. 
Whalen. 

 
Miscellaneous Footnote and Bibliographic Forms for Printed Sources 

 
Magazine Articles. Magazines such as Christianity Today and Modern Reformation that publish 
at least twelve issues a year fit into Turabian’s category of “magazines of general interest” 
(15.231). Magazine citations resemble journal citations, but the date takes the place of the volume 
number, is preceded by a comma, and is not enclosed in parentheses. Note the following: 
 

FN:  1William M. Kinnaird, “Divorce and Remarriage: Ministers in the Middle,” Christianity 

Today, 6 June 1980, p. 24. 
   

  2Kinnaird, “Divorce and Remarriage,” p. 26. 
 

B: Kinnaird, William M. “Divorce and Remarriage: Ministers in the Middle.” Christianity Today, 6 
June 1980, pp. 24–27. 

 
Note: For articles that begin in the front of a magazine then skip to the back, inclusive page 
numbers are meaningless. In this situation include only the first page of the article in a 
bibliographic entry. 

 
Book Review.  
 

FN:  1David L. Turner, review of Daniel, by John C. Whitcomb, GTJ 8 (Fall 1987): 292. 

  2Turner, review of Daniel, p. 292. 

B: Turner, David L. Review of Daniel, by John C. Whitcomb. Grace Theological Journal 8 (Fall 
1987): 292–93. 

Theses and Dissertations. 
 

FN:  1William W. Combs, “The Blasphemy Against the Holy Spirit” (Th.D. dissertation, Grace 
Theological Seminary, 1985), p. 14. 

  2Combs, “Blasphemy Against the Holy Spirit,” p. 120. 

B: Combs, William W. “The Blasphemy Against the Holy Spirit.” Th.D. dissertation, Grace 
Theological Seminary, 1985. 
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Seminar and Society Papers. 
 

FN:   
1Mark A. Snoeberger, “The Identity of Behemoth and Leviathan in the Book of Job” 

(Seminar in Old Testament Wisdom Theology, Detroit Baptist Theological Seminary, 2 November 
1999), p. 26. 

 

  2Snoeberger, “Behemoth and Leviathan,” p. 28. 
 

B: Snoeberger, Mark A. “The Identity of Behemoth and Leviathan in the Book of Job.” Seminar in 
Old Testament Wisdom Theology, Detroit Baptist Theological Seminary, 2 November 
1999. 

 
FN:  

1Bruce A. Ware, “Male Priority in Man and Woman as the Images of God” (paper 
presented at the 52nd annual meeting of the Evangelical Theological Society, Nashville, TN, 
16 November 2000), pp. 4–5.  

 

  2Ware, “Male Priority,” p. 8. 
 

B: Ware, Bruce A. “Male Priority in Man and Woman as the Images of God.” Paper presented at the 
52nd annual meeting of the Evangelical Theological Society, Nashville, TN, 16 November 
2000. 

 
Class Notes. 
 

FN:  
1Rolland D. McCune, “Systematic Theology II” (class notes, Detroit Baptist Theological 

Seminary, Fall 2001), p. 58. 
 

  2McCune, “Systematic Theology II,” p. 67. 
 

B: McCune, Rolland D. “Systematic Theology II.” Class notes, Detroit Baptist Theological Seminary, 
Fall 2001. 

Classical References. Classical reference form is commonly used for classical and medieval 
literature, but is not limited thereto. The criterion for using classical reference form is not 
antiquity, but the organization of the text into recognized divisions that are independent of 
pagination in multiple critical editions and translations. In this form it is standard to omit facts of 
publication in footnote references unless it one is citing the precise wording of a particular edition 
or translation. The overuse of abbreviations in classical reference form is discouraged. The rule of 
thumb is to give as much information as is necessary for the reader to relocate the source. Note 
the following: 

FN:  
1Irenaeus Against Heresies 3.18.7, in ANF, 1:448.   

 
  2Irenaeus Against Heresies 4.9.2. 
 
B: Irenaeus. Against Heresies. Translated by A. Roberts and W. H. Rambaut. In vol. 1 of the Ante-

Nicene Fathers, vol. 1. American ed. Reprint of 1885 ed. Grand Rapids: Eerdmans, 1975. 
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FN:  
1Augustine Confessions 11.20, in Basic Writings of St. Augustine, ed. Whitney J. Oates, 2 

vols. (reprint of 1948 ed., Grand Rapids: Baker, 1980), 1:195.  
 

  2Augustine Confessions 12.23. 
 

B: Augustine. The Confessions. In Basic Writings of St. Augustine. Edited by Whitney J. Oates. 2 vols. 
Reprint of 1948 ed. Grand Rapids: Baker, 1980. 

 
FN:   

1John Calvin Institutes of the Christian Religion 4.20.9, ed. John T. McNeill, trans. Ford 
Lewis Battles, LCC, vols. 20–21 (Philadelphia: Westminster, 1960), pp. 1495–96.  

 

  2Calvin Institutes 1.13.3. 
 

B: Calvin, John. Institutes of the Christian Religion. Edited by John T. McNeill. Translated by Ford 
Lewis Battles. Library of Christian Classics, vols. 20–21. Philadelphia: Westminster, 1960. 

 
Secondary Source of Quotation. 

 
FN:  1B. C. Butler, The Originality of St. Matthew (Cambridge: University Press, 1951), p. 45, 

quoted in Simon J. Kistemaker, The Gospels in Current Study, 2nd ed. (Grand Rapids: Baker, 
1980), p. 99. 

 

B: Butler, B. C. The Originality of St. Matthew. Cambridge: University Press, 1951, p. 45. Quoted in 
Simon J. Kistemaker. The Gospels in Current Study. 2nd ed. Grand Rapids: Baker, 1980, p. 
99. 

 

 

 

Documentation of Electronic Sources 
 

Electronic sources present the writer with several significant complications that are not easily 
remedied by referencing guidelines. First, electronic sources are transient. URLs and ISPs tend to 
change on a daily basis, and a document available today may be gone tomorrow. Further, rapid 
changes in data storage can render data inaccessible. Second, electronic sources are prone to 
frequent, undocumented revision. Third, most electronic sources are not paginated, making 
relocating material a frustrating task. Read these general guidelines carefully, then follow the 
examples provided to give as full and accurate a reference as is possible.  
 

General Guidelines. 
 

• Always refer to print sources if they are available. This relieves the problems of 
transience, pagination, and poor scanning techniques common to electronic sources. 

• If an electronic document is a reproduction of a print source that is not available to you, 
include as much information about the original print source as is available.  

• If authorship of an electronic source cannot be definitely established, the student is 
strongly encouraged not to use the source. A website is not an authority, and is essentially 
an anonymous source apart from clear authorship. 
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• Citation of articles that do not have fixed page numbers or paragraph numbers should 
identify the location of the cited material by chapter titles or section headings preceded 
by the word under.  

• Indicate the type of source being referenced with a URL, or the designation “microfiche,” 
“CD-ROM,” etc. 

• Internet citations should include a date accessed after the site address. 

• Since electronic sources tend to be transient, download a copy of the electronic source to 
a disk or make a hard copy for future reference. 

• When citing an URL address, turn off the hyperlink function on your word processor. 
URL addresses should appear in black font without underlining. If it is necessary to break 
a URL address to fit on a line, break the address at a slash (/) in the address. 

 
Formally Published Electronic Sources. Some electronic sources differ from their print 
counterparts in nothing other than their media. These include formally published journals, e-
books, and databases that appear online or on physical media such as microform, CD-ROMs, and 
DVDs. Cite these just as print books and articles, but add information to direct the reader to the 
electronic version used. 

 
Electronic journal article online: 
 

FN:   1David Marcus, “Aramaic Mnemonics in Codex Leningradensis,” TC: A Journal of Biblical 

Textual Criticism 4 (1999), par. 4, http://rosetta.atla-certr.org/TC/vol04/Marcus1999.html (accessed 
5 June 2002). 

 

   2Marcus, “Aramaic Mnemonics,” par. 6. 
 
B: Marcus, David. “Aramaic Mnemonics in Codex Leningradensis.” TC: A Journal of Biblical Textual 

Criticism 4 (1999). http://rosetta.atla-certr.org/TC/vol04/Marcus1999.html (accessed 5 June 
2002). 

 
CD-ROM source: 
 
FN:   1Cornelius Van Til, Paul at Athens (Philadelphia: Presbyterian and Reformed, 1954), under 

“Culpable Ignorance,” in The Works of Cornelius Van Til, 1895–1987 (Oak Harbor, WA: Logos 
Library System, 1998), CD-ROM. 

 

   2Van Til, Paul at Athens, under “The Frame of Reference.” 
 

B: Van Til, Cornelius. Paul at Athens. Philadelphia: Presbyterian and Reformed, 1954. In The Works 

of Cornelius Van Til, 1895–1987. Oak Harbor, WA: Logos Library System, 1998. CD-
ROM. 
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Microform source: 
 

FN:   1J. R. Mantey, “The Causal Use of Eis in the New Testament,” JBL 70 (1951): 46, 
microfiche.  

 

  2Mantey, “Causal Use of Eis,” p. 47. 
 

B: Mantey, J. R. “The Causal Use of Eis in the New Testament.” Jornal of Biblical Literature 70 
(1951): 45–48. Microfiche. 

 
 Article from Electronic Database: 
 

FN:  
1Dale Aukerman, “The Biblical and Theological Basis of Reconciliation,” Brethren Life 

and Thought 41 (Spring/Summer 1996): 12, ATLAS Serials online,  http://newfirstsearch.oclc.org/ 
WebZ/FTFETCH?sessionid=fsapp8-42675-fhz8rqhe-cf2chb:entitypagenum=43:0:rule=100: 
fetchtype=fulltext:dbname=ATLA_FT:recno=2:resultset=5:ftformat=PDF:format=BI:isbillable=TR
UE:numrecs=1:isdirectarticle=FALSE:entityemailfullrecno=2:entityemailfullresultset=5:entityemai
lftfrom=ATLA_FT:, (accessed 27 June 2008).  

 

  2Aukerman, “Biblical and Theological Basis of Reconciliation,” p. 14. 
 

B: Aukerman, Dale. “The Biblical and Theological Basis of Reconciliation.” Brethren Life and Thought 
41 (Spring/Summer 1996): 10–18. ATLAS Serials online. http://newfirstsearch.oclc.org/ 
WebZ/FTFETCH?sessionid=fsapp8-42675-fhz8rqhe-cf2chb:entitypagenum=43:0: 
rule=100:fetchtype=fulltext:dbname=ATLA_FT:recno=2:resultset=5:ftformat=PDF:format
=BI:isbillable=TRUE:numrecs=1:isdirectarticle=FALSE:entityemailfullrecno=2:entityemai
lfullresultset=5:entityemailftfrom=ATLA_FT: (accessed 27 July 2008). 

 
 

Informally Published Electronic Sources. 
 

Signed, dated article on the World Wide Web: 
 

FN:   1Charles H. Powell, “Progression Versus Recapitulation in Revelation 20:1–6: Some 
Overlooked Arguments,” par. 12, article posted 14 August 2000 at http://www.bible.org/docs/ 
soapbox/scholars/rev20.htm (accessed 5 June 2002).  

 

  2Powell, “Progression Versus Recapitulation,” par. 14. 
 

B:     Powell, Charles H. “Progression Versus Recapitulation in Revelation 20:1–6: Some Overlooked 
Arguments.” Article posted 14 August 2000 at http://www.bible.org/docs/soapbox/scholars/ 
rev20.htm (accessed 5 June 2002). 

 
 

Unsigned, undated article on the World Wide Web (author is site owner): 
 

FN:  1Detroit Baptist Theological Seminary, “Statement of Faith,” 2.1.4, http://www.dbts.edu/ 
faithstatem.html (accessed 5 June 2002). 

 

  2Detroit Baptist Theological Seminary, “Statement of Faith,” 2.1.3. 
 

B: Detroit Baptist Theological Seminary. “Statement of Faith.” http://www.dbts.edu/faithstatem.html 
(accessed 5 June 2002).   
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Weblog Entry or Comment.  

FN:  1Mark Dever, “Mark Dever Doesn’t Practice Separation?” The 9Marks Blog, entry posted 
14 June 2008, http://blog.9marks.org/2008/06/mark-dever-do-1.html (accessed 30 June 2008). 

   2Dever, “Dever Doesn’t Practice Separation?” 

B:  Dever, Mark. “Mark Dever Doesn’t Practice Separation?” The 9Marks Blog. Entry posted 14 June 
2008. http://blog.9marks.org/2008/06/mark-dever-do-1.html (accessed 30 June 2008). 

FN:    1Dave [Doran], comment on “Mark Dever Doesn’t Practice Separation?” The 9Marks Blog, 
comment posted 15 June 2008, http://blog.9marks.org/2008/06/mark-dever-do-1.html#comments 
(accessed 30 June 2008). 

   2[Doran], comment on “Dever Doesn’t Practice Separation?” 

B: [Doran], Dave. Comment on “Mark Dever Doesn’t Practice Separation?” The 9Marks Blog. 
Comment posted 15 June 2008. http://blog.9marks.org/2008/06/mark-dever-do-
1.html#comments (accessed 30 June 2008). 
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Formatting Your Paper in Microsoft Word XP/2003: How to Do It 
 

 

Inserting Footnotes 

Place your cursor at the point in your text 
where you want a footnote. 

Under the Insert drop-down menu select 
Footnote. 

Select Options. 
Under Place at select bottom of page. 
Under Numbering select Continuous (In 

the Th.M. thesis this allows the writer 
to write the entire thesis in a single 
document, each chapter a successive 
section with continuous footnotes). 

 Click OK. 
 
Note: Once the initial footnote is inserted, 

successive footnotes can be added 
simply by keying Control/Alt   F. 

 
Formatting Footnotes 

Under the View drop-down menu, select 
Normal. (Some of these instructions 
will work only in this view.) 

To create proper separator lines: 
 Click on the View drop-down menu. 
 Select Footnotes. 
 In the new footnote box select 

Footnote Separator. 
 Key in a 2” line and hit enter, inserting 

a single blank line. 
 Highlight the line and space you just 

made and copy it (Control+ C) 
 Select Footnote Continuation 

Separator. 
 Delete the default line. 
 Paste (Control+ P) the 2” line and 

space from your buffer. 
 
Note: to avoid indenting and spacing each 

note individually and to create notes in 
your preferred font size, create a style 
for footnote text. 

 
 

Eliminating Gaps and Footnotes that 

Appear on the Wrong Page 
 
Turn off Orphan/Widow Control: 
 Under the Format drop-down menu, 

select Paragraph. 
 Click the Line and Page Breaks tab. 
 Uncheck Widow/Orphan Control. 
 
 Repeat these procedures for 

paragraphs within footnotes. 
 
Note: This procedure will affect only a 

highlighted area or the paragraph in 
which the cursor is located. It is best to 
set paragraph style before writing. If 
you don’t, highlight the entire paper 
before following these steps. 

 
Use Printer Metrics: 

 Under the Tools drop-down menu, 
select Options. 

Click on the Compatibility tab. 
Scroll down to Use printer metrics to 

lay out document and check the 
box. 

 
Note: This procedure works only with 

Macintosh and older versions of Word. 
On other versions unchecking this box 
will improve the format.  

 
Rework the Paragraph: In some cases the 

only solution is to rewrite sentences or 
consolidate a cluster of footnotes to 
eliminate unsightly gaps and footnotes 
that are forced to the next page. 
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Formatting Your Paper in Microsoft Word 2007: How to Do It 
 

 

Inserting Footnotes 

Place your cursor at the point in your text 
where you want a footnote. 

Click on the References tab. 
In the Footnotes box click Insert Footnote.  
 
Note: For a quicker way of doing this, simply 
key Control/Alt/F. 
 

Formatting Footnotes 

Appearance: 

Click on the References tab. 
Open the Footnotes dialog box launcher. 
Under Location select bottom of page. 
Under Numbering select Continuous (In the 

Th.M. thesis this allows the writer to write 
the entire thesis in a single document, each 
chapter a successive section with 
continuous footnotes). 

Click Apply. 
 
Footnote Separator: 

Click on the View tab. 
Under Document Views select Draft (the 

instructions below will work only in this 
view.) 

Click on the References tab. 
Under Footnotes select Show Notes 

In Footnotes ribbon that appears at the bottom 
of the page select Footnote Separator. 

Key in a 2” line (default). 
Highlight the line you just made and copy it 

(Control/C). 
In Footnotes ribbon that appears at the bottom 

of the page select Footnote Continuation 

Separator. 
Delete the default line. 
Paste (Control/P) the 2” line from your buffer. 
 
Indentation, Spacing, and Fonts 

Avoid having to change indentation, font 
style, and spacing for each note by modifying 
the normal footnote style: 

Right click on any footnote. 
From the popup menu select Style. 

The footnote text style will be highlighted. 
Select Modify. 
Set font style to Times New Roman and font 

size to 10. 
At the bottom of the popup screen select 

Format. 
In the popup screen that appears select 

Paragraph. 
Click on Indents and Spacing 

 Under Indentation select the following: 
  Special: First Line. 
  By: 0.5” 
 Under Spacing select the following: 
  After: 6 pts. 
  Line Spacing: Single 
Click on Line and Page Breaks 
 Uncheck the box marked Widow/ Orphan 

Control. 
Click OK. 
In the Modify Style Screen click OK. 
In the Style screen click Apply. 

Note: It is impossible to set the style to 
eliminate the space that appears after the 
note number. This must be done manually 
for each note.  

 
Eliminating Gaps and Footnotes that 

Appear on the Wrong Page 
 
Turn off Orphan/Widow Control: 

Click on the Home tab. 
Open the Paragraph dialog box launcher. 
Click on the Line and Page Breaks tab. 

 Uncheck the box marked Widow/ Orphan 

Control. 

Click OK to make the change locally or 
Default to make this change part of 
the normal style. 

Note: This procedure must be done both in the 
text and footnotes.  
  
Rework the Paragraph: If this does not work, 

rewrite the paragraph, paying special 
attention to the consolidation of clusters of 
footnotes. 
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Appendix 1: Guidelines for Writing an Acceptable  

Critical Book Review  

 
The analysis of books falls basically under two heads: the report and the review. A report is a 
descriptive but largely non-evaluative summary of the content of a book. A review is a critical 
interpretive analysis of a book with a view to factors such as its strengths, weaknesses, biases, 
organization, effectiveness, and credibility. Unless otherwise instructed, seminary book analyses are 
expected to take the form of a critical book review. 
 

By critical review is not meant a negative review, but one that is analytical and evaluative. A critical 
review may, in fact, be quite positive, but only after a thorough appraisal of the content of the book.  
 

A critical book review will include: 
 

• Any pertinent qualifications that the author has to write on the topic of the book, paying 
special attention to other publications, educational background, vocational interests, etc., that 
might inform or bias his understanding of the topic.  

• An establishment of the book’s thesis. Note that the thesis is sometimes stated and sometimes 
must be inferred, and at times it there may be both a cosmetic and a “real” thesis. A careful 
reviewer will discern these. State and explain why you believe the author succeeded or failed 
in proving his thesis.  

• A brief, encapsulated summary of the author’s argument. This should appear early in the 
review and should not exceed 20% of the critical review (note that this is unlike book reviews 
common in professional journals, which give greater attention to content summaries for the 
evaluation of prospective buyers). Under no circumstances should a review consist merely of 
a seriatim summary or abridgement of the book.  

• An identification of the author’s arguments, distinguishing principal arguments from lesser 
ones and giving priority to the former.  

• An evaluation of the author’s use of logic, evidence and counter-evidence. Do his arguments 
follow? Does he ignore/dismiss counter-claims or answer them honestly? 

• A demonstration of familiarity with other germane literature, comparing and contrasting 
these with the book under review and explaining the distinctive contribution of the reviewed 
work to the body of literature on the topic.  

• A summary assessment of either commendation or disapproval. All books have strengths and 
weaknesses and these should be recognized; however, you should be able to conclude with a 
succinct, pregnant statement of the book’s overall value for prospective readers.  
 

A critical book review will exclude: 
 

• Lengthy book summaries. Remember, it is a review, not a report. 

• Extraneous biographical details that have no bearing on the book’s content.  

• Comments about irrelevant editorial minutiae (e.g., misspellings, page layout, etc.) unless 
these are so poor as to damage the credibility or understandability of the book. 

• Ad hominem attacks. If you disagree with the author, explain why he is wrong in a detached, 
irenic manner. 

• Broad, unsubstantiated, and subjective comments (e.g., “this book wasn’t very good”; “I 
thought the book was interesting”; “this book just didn’t speak to me”). Such sentiments 
emerge much more effectively and professionally through objective analysis.     
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Appendix 2: Abbreviations & Capitalization  
 

 

PART 1: ABBREVIATIONS OF THE NAMES OF BIBLICAL  

BOOKS (WITH THE APOCRYPHA) 
 

 
Gen Song or Cant 1–2–3–4 Kgdms John 
Exod Isa Add Esth Acts 
Lev Jer Bar Rom 
Num Lam Bel 1–2 Cor 
Deut Ezek 1–2 Esdr Gal 
Josh Dan 4 Ezra Eph 
Judg Hos Jdt Phil 
Ruth Joel Ep Jer Col 
1–2 Sam Amos 1–2–3–4 Macc 1–2 Thess 
1–2 Kgs Obad Pr Azar 1–2 Tim 
1–2 Chr Jonah Pr Man Titus 
Ezra Mic Sir Phlm 
Neh Nah Sus Heb 
Esth Hab Tob Jas 
Job Zeph Wis 1–2 Pet 
Ps (pl.: Pss) Hag Matt 1–2–3 John 
Prov Zech Mark Jude 
Eccl (or Qoh) Mal Luke Rev 

 
 

PART 2: PUBLISHERS’ NAMES:  

SHORTENED FORMS 
 

Abingdon Press Abingdon 
Accent Books Accent 
Augsburg Publishing Co.  Augsburg 
Augsburg Fortress, Publishers Augsburg Fortress 
Baker Book House Baker 
The Banner of Truth Trust Banner of Truth 
Bethany House Publishers Bethany House 
Blackwell Publishers Blackwell 
Broadman Press Broadman 
Broadman & Holman Press Broadman & Holman 
College Press Publishing Co. College Press 
Concordia Publishing House Concordia 
Crossway Books Crossway 
Walter de Gruyter de Gruyter 
Doubleday & Co.  Doubleday 
Wm. B. Eerdmans Publishing Co. Eerdmans 
Fortress Press Fortress 
Good News Publishers/Crossway Books  Crossway 
Harper & Row, Publishers Harper & Row 
Harvest House Publishers Harvest House 
Hendrickson Publishers, Inc. Hendrickson 
Herald Press Herald 
InterVarsity Press InterVarsity Press 
John Knox Press John Knox 



 43

Kregel Publications Kregel 
Liturgical Press, The Liturgical 
Loizeaux Brothers Loizeaux 
Macmillan Co., The Macmillan 
Edwin Mellen Press Mellen 
J. C. B. Mohr Mohr 
Moody Press Moody Press 
Multnomah Press Multnomah Press 
Thomas Nelson, Inc. Nelson 
Oxford University Press Oxford University Press 
Paternoster Publishing USA Paternoster 
Paulist Press Paulist 
P & R Publishing Co. P & R 
Presbyterian & Reformed Publishing Co. Presbyterian & Reformed 
Regal Books Regal 
Fleming H. Revell Co. Revell 
Charles Scribner’s Sons Scribner’s 
Sheffield Academic Press Sheffield 
Tyndale House Publishers, Inc. Tyndale 
Victor Books Victor 
The Westminster Press Westminster 
Westminster/John Knox Press Westminster/John Knox 
Word, Inc. or Word Books Word 
Zondervan Publishing House Zondervan 
 
 
 

PART 3: TEXTS AND VERSIONS OF THE BIBLE  
 
 

Ancient Texts and Editions 
 

BHK Biblia Hebraica, R. Kittel, ed. 
BHL Biblical Hebraica Leningradensia 
BHS Biblia Hebraica Stuttgartensia  

DSS Dead Sea Scrolls 
LXX Septuagint 
MT Masoretic Text 
NA27 Novum Testamentum Graece, Nestle-Aland, 27th ed. 
TR Textus Receptus 

UBS4 The Greek New Testament, United Bible Societies, 4th ed. 
Vg Vulgate 
WH Westcott-Hort 

 

 

English Versions 

 
AMPLIFIED Amplified Bible (1958–65) 
ARV American Revised Version (1901; U.S. edition of ERV) 
ARV, mg American Revised Version, margin 
ASV American Standard Version (1901) 
AT The Complete Bible: An American Translation (Goodspeed and Smith; NT 1923; OT 

1927) 
AV Authorized Version (1611; same as KJV) 
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BARCLAY The New Testament (Barclay; 1968–69) 
BECK New Testament in Language of Today (Beck; 1963) 
BISHOP The Bishop’s Bible (1568) 
BV Berkeley Version in Modern English (NT 1945; OT 1959) 
 
CEV Contemporary English Version (1995) 
COVERDALE Coverdale Bible (1535) 
 
DV Douay–Rheims Bible (same as Douay Version; 1609–10) 
DV Douay Version (1609–10) 
 
EB Emphasized Bible (Rotherham; NT 1897; OT 1902) 
ERV English Revised Version (NT 1881; OT 1885; Apoc. 1895; same as RV) 
ERV, mg English Revised Version, margin 
ESV English Standard Version (2001) 
 
GENEVA Geneva Bible (1560) 
GNB Good News Bible (same as TEV; NT 1966; OT 1976) 
GOODSPEED The Complete Bible: An American Translation, E. J. Goodspeed (NT 1935; OT 1939) 
 
HCSB Holman Christian Standard Bible (NT 2000) 
 
JB Jerusalem Bible (French 1956; English 1966) 
JPS Holy Scriptures: Jewish Publication Society Version of the Old Testament (1917) 
 
KJII King James II Version (1971) 
KJV King James Version (same as Authorized Version; 1611) 
KNOX Holy Bible: A Translation from the Latin Vulgate in the Light of the Hebrew and Greek 

Original (Knox; NT 1945; OT 1949) 
 
LAMSA Holy Bible from Ancient Eastern Manuscripts (Lamsa; 1957) 
LB The Living Bible (NT 1967; OT 1971) 
LB The Book (same as The Living Bible) 
 
MATTHEW Matthew’s Bible (1537) 
MLB Modern Language Bible (same as New Berkeley Version; 1969) 
MLB New Berkeley Version in Modern English (same as Modern Language Bible; 1969) 
MOFFATT A New Translation of the Bible (Moffat; NT 1913; OT 1924) 
 
NAB New American Bible (NT 1941; OT 1969) 
NASB New American Standard Bible (NT 1963; OT 1971) 
NASU New American Standard Bible, updated ed. (1995) 
NAV New American Version 

NEB New English Bible (NT 1961; OT and Apoc. 1970) 
NET The Net Bible: New English Translation (2003) 
NIrV New International Reader’s Version (OT 1995; NT 1996; revised 1998) 
NIV New International Version (NT 1973; OT 1978) 
NIVSB NIV Study Bible (1985) 
NJB New Jerusalem Bible (1985) 
NJPS Tanakh: The Holy Scriptures: The New JPS Translation According to the Traditional 

Hebrew Text (1988; revised 1999) 
NJV New Jewish Version (1962–82) 
NKJV New King James Version (1979) 
NLT New Living Translation (1996) 
NLTse New Living Translation, 2nd ed. (2004) 
NRSV New Revised Standard Version (1990) 
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NSRB New Scofield Reference Bible (KJV; 1967) 
NWT New World Translation of the Holy Scriptures (Jehovah’s Witnesses; 1961) 
 
OAB Oxford Annotated Bible (RSV; 1962) 
 
PHILLIPS New Testament in Modern English (Phillips; 1958; revised 1973) 
 
RDB Reader’s Digest Bible (condensed RSV; 1982) 
REB Revised English Bible (1989) 
RHEIMS Rheims New Testament (NT of DV; 1582) 
RSV Revised Standard Version (NT 1946; OT 1952; Apoc. 1957) 
RV Revised Version (NT 1881; OT 1885; Apoc. 1895) 
RV, mg Revised Version, margin 
 
SRB Scofield Reference Bible (KJV; 1909) 
 
TCNT Twentieth Century New Testament (1898–1901) 
TEV Today’s English Version (same as GNB; NT 1966; OT 1976) 
TNIV Today’s New International Version (NT 2002) 
TYNDALE Tyndale New Testament (1526) 
 
WEYMOUTH Weymouth’s New Testament in Modern Speech (1903) 
WILLIAMS New Testament: A Translation in Language of the People (Williams; 1937) 
WYCLIFFE Wycliffe Bible (1380) 
 
YOUNG Literal Translation of the Bible (Young; 1862) 
 
 
 

PART 4: ABBREVIATIONS OF COMMONLY USED 

PERIODICALS, REFERENCE WORKS, & SERIALS 
 
 

AARSBLA American Academy of Religion/Society of Biblical Literature Abstracts 
AASOR Annual of the American Schools of Oriental Research 
AB Anchor Bible 
ABD Anchor Bible Dictionary, D. N. Freedman (ed.) 
ABQ American Baptist Quarterly 
ACCS Ancient Christian Commentary on Scripture 
ACW Ancient Christian Writers 
AJA American Journal of Archaeology 

AJBA Australian Journal of Biblical Archaeology 

AJP American Journal of Philology 

AJSL American Journal of Semitic Languages and Literature 

AJT American Journal of Theology 

ALUOS   Annual of Leeds University Oriental Society 

AnBib Analecta Biblica 
ANEP Ancient Near East in Pictures, J. B. Pritchard (ed.) 
ANESTP Ancient Near East Supplementary Texts and Pictures, J. B. Pritchard (ed.) 
ANET Ancient Near Eastern Texts, J. B. Pritchard (ed.) 
ANF The Ante-Nicene Fathers 
ANQ Andover Newton Quarterly 

ANRW Aufsteig und Niedergang der römischen Welt 
AOS American Oriental Series 
AOSTS American Oriental Society Translation Series 
APOT Apocrypha and Pseudepigrapha of the Old Testament, R. H. Charles (ed.) 
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ARE Ancient Records of Egypt, J. H. Breasted (ed.) 
ASOR American Schools of Oriental Research 
ASP American Studies in Papryology 
AsTJ   Asbury Theological Journal 

ATJ   Ashland Theological Journal 

ATR Anglican Theological Review 

AusBR Australian Biblical Review 

AUSS Andrews University Seminary Studies 

 
BA Biblical Archaeologist 

BAGD W. Bauer, W. F. Arndt, F. W. Gingrich, and F. W. Danker, Greek– 

English Lexicon of the NT, 2nd ed. 

BAR Biblical Archaeologist Reader 

BARev   Biblical Archaeology Review 

BASOR Bulletin of the American Schools of Oriental Research  

BASP   Bulletin of the American Society of Papyrologists 

BBR   Bulletin of Biblical Research 

BCOTWP   Baker Commentary on the Old Testament Wisdom and Psalms 
BCSR Bulletin of the Council of the Study of Religion 

BDAG W. Bauer, F. W. Danker, W. F. Arndt, and F. W. Gingrich, Greek– 

  English Lexicon of the NT, 3rd ed. 
BDB F. Brown, S. R. Driver, and C. A. Briggs, Hebrew and English Lexicon of the Old 

Testament 

BDF F. Blass, A. Debrunner, and R. W. Funk, A Greek Grammar of the NT 
BDR F. Blass, A. Debrunner, and F. Rehkopf, Grammatik des neutestamentlichen Griechisch 

BECNT Baker Exegetical Commentary on the New Testament 
BETS Bulletin of the Evangelical Theological Society 

BFT Biblical Foundations in Theology 
BHS Biblia Hebraica Stuttgartensia 

Bib Biblica 

BibInt Biblical Interpretation 

BibRev Bible Review 

BIES Bulletin of the Israel Exploration Society (=Yediot) 

BIOSCS Bulletin of the International Organization for Septuagint and Cognate Studies 

BJPES Bulletin of the Jewish Palestine Exploration Society 

BJRL Bulletin of the John Rylands University Library of Manchester 

BJS Brown Judaic Studies 
BK Bibel und Kirche 

BN Biblische Notizen 

BNTC Black’s New Testament Commentary 

BO Bibliotheca orientalis 

BQ    Baptist Quarterly 

BR Biblical Research 

BRT Baptist Review of Theology 

BSac Bibliotheca Sacra 

BSC Bible Student’s Commentary 
BST Bible Speaks Today 
BT The Bible Translator 

BTB Biblical Theology Bulletin 

BurH Buried History 

BZ Biblische Zeitschrift 

BZAW Beihefte zur Zeitschrift für die alttestamentliche Wissenschaft t 

BZNW Beihefte zur Zeitschrift für die neustestamentliche Wissenschaft 

 
CAD The Assyrian Dictionary of the Oriental Institute of the University of Chicago 
CAH Cambridge Ancient History 
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CANE Civilizations of the Ancient Near East, J. Sasson (ed.)  
CBC Cambridge Bible Commentary 
CBQ Catholic Biblical Quarterly 
CBQMS Catholic Biblical Quarterly—Monograph Series 
CC Communicators Commentary 
CGTC Cambridge Greek Testament Commentaries 
CH Church History 
CHR Catholic Historical Review 
CJT Canadian Journal of Theology 
CP Classical Philology 
CQ Church Quarterly 
CQR Church Quarterly Review 
CR Critical Review of Books in Religion 

CRBR Critical Review of Books in Religion 

CSR Christian Scholar’s Review 

CTJ Calvin Theological Journal 
CTM Concordia Theological Monthly 

CTQ Concordia Theological Quarterly 

CTR Criswell Theological Review 
CurTM Currents in Theology and Mission 
 
DBI Dictionary of Biblical Imagery, L. Ryken et al. (eds.) 
DBSJ Detroit Baptist Seminary Journal 

DCH Dictionary of Classical Hebrew, D. J. A. Clines (ed.) 
DHT Dictionary of Historical Theology, T. A. Hart (ed.) 
DJD Discoveries in the Judaean Desert 
DJG Dictionary of Jesus and the Gospels, J. B. Green et al. (eds.) 
DLNTD Dictionary of the Later New Testament and Its Developments, R. P. Martin and P. H. 

Davids (eds.) 
DOTT Documents from Old Testament Times, D. W. Thomas (ed.) 
DNTB Dictionary of New Testament Background, C. A. Evans and S. E. Porter (eds.) 
DPL Dictionary of Paul and His Letters, G. F. Hawthorne et al. (eds.) 
DSD Dead Sea Discoveries 
 
ECC Eerdman’s Critical Commentary 
EDB Encyclopedic Dictionary of the Bible, L. F. Hartman (ed.) 
EDT Evangelical Dictionary of Theology, W. A. Elwell (ed.) 
EDBT Evangelical Dictionary of Biblical Theology, W. A. Elwell (ed.) 
EDNT Exegetical Dictionary of the New Testament, H. Balz and G. Schneider (eds.) 
EJT European Journal of Theology 

EMQ Evangelical Missions Quarterly 

EncJud Encyclopaedia Judaica (1971) 

ErIsr Eretz Israel 

EvJ Evangelical Journal 

EvQ Evangelical Quarterly 
EvT Evangelische Theologie 

EWNT Exegetisches Wörterbuch zum Neuen Testament, H. Balz and G. Schneider (eds.) 
ExpTim Expository Times 

 
FC Fathers of the Church 
FOTL Forms of the Old Testament Literature 
 
GKC Gesenius’ Hebrew Grammar, ed. E. Kautzsch, tr. A. E. Cowley 
GNS Good News Studies 
GOTR Greek Orthodox Theological Review 
GTJ Grace Theological Journal 
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HALOT Hebrew and Aramaic Lexicon of the Old Testament, W. Baumgartner et al. (eds.) 
HAR Hebrew Annual Review 
HBC Harper’s Bible Commentary, J. L. Mays et al. (eds.) 
HBD Harper’s Bible Dictionary, P. J. Achtemeier et al. (eds.) 
HBT Horizons in Biblical Theology 
HDR Harvard Dissertations in Religion 
HeyJ Heythrop Journal 

HNTC Harper’s NT Commentaries 
HolNTC Holman New Testament Commentary 
HR History of Religions 
HS Hebrew Studies 
HSM Harvard Semitic Monographs 
HSS Harvard Semitic Studies 
HTR Harvard Theological Review 
HTS Harvard Theological Studies 
HUCA Hebrew Union College Annual 
HUCM Monographs of the Hebrew Union College 
 
IB Interpreter’s Bible 

IBC Interpretation: A Bible Commentary for Teaching and Preaching 
IBS Irish Biblical Studies 
ICC International Critical Commentary 
IDB Interpreter’s Dictionary of the Bible, G. A. Buttrick (ed.) 
IDBSup Supplementary volume to IDB 
IEJ Israel Exploration Journal 
Int Interpretation 
IOS Israel Oriental Society 
ISBE International Standard Bible Encyclopedia, rev., G. W. Bromiley (ed.) 
ITC International Theological Commentary 
ITQ Irish Theological Quarterly 

IVPNTC IVP New Testament Commentary 
 
JAAR Journal of the American Academy of Religion 

JANESCU Journal of the Ancient Near Eastern Society of Columbia University 
JAOS Journal of the American Oriental Society 
JAS Journal of Asian Studies 

JBC The Jerome Biblical Commentary, R. E. Brown et al. (eds.) 
JBL Journal of Biblical Literature 

JBQ Jewish Bible Quarterly 
JBR Journal of Bible and Religion 

JCS Journal of Cuneiform Studies 

JECS Journal of Early Christian Studies 

JEH Journal of Ecclesiastical History 

JES Journal of Ecumenical Studies 

JETS Journal of the Evangelical Theological Society 

JFSR Journal of Feminist Studies in Religion 
JHNES Johns Hopkins Near Eastern Studies 
JJS Journal of Jewish Studies 

JNES Journal of Near Eastern Studies 

JNSL Journal of Northwest Semitic Languages 

JOTT Journal of Translation and Textlinguistics  

JPOS Journal of Palestine Oriental Society 

JQR Jewish Quarterly Review 

JQRMS Jewish Quarterly Review Monograph Series 
JR Journal of Religion 
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JRE Journal of Religious Ethics 

JRelS Journal of Religious Studies 

JRH Journal of Religious History 

JSNT Journal for the Study of the New Testament 

JSNTSup Journal for the Study of the New Testament—Supplement Series 
JSOT Journal for the Study of the Old Testament 

JSOTSup Journal for the Study of the Old Testament—Supplement Series 
JSP Journal for the Study of the Pseudepigrapha  

JSPSup Journal for the Study of the Pseudepigrapha—Supplement Series 
JSS Journal of Semitic Studies 

JSSR Journal for the Scientific Study of Religion 

JTC Journal for Theology and the Church 

JTS Journal of Theological Studies 

 
KB L. Koehler and W. Baumgartner, Lexicon in Veteris Testamenti libros 
 
LCC Library of Christian Classics 
LCL Loeb Classical Library 
LPGL G. W. H. Lampe, Patristic Greek Lexicon 
LQ Lutheran Quarterly 

LS Louvain Studies 

LSJ Liddell-Scott-Jones, Greek–English Lexicon 

LTQ   Lexington Theological Quarterly 

 
MC Modern Churchman 

MM J. H. Moulton and G. Milligan, The Vocabulary of the Greek Testament 
MNTC Moffatt NT Commentary 
 
NAC New American Commentary 
NBC New Bible Commentary 
NBD New Bible Dictionary, J. D. Douglas (ed.) 
NCB New Century Bible 
NCCHS New Catholic Commentary on Holy Scripture, R. D. Fuller et al. (eds.) 
NCE New Catholic Encyclopedia, M. R. P. McGuire et al. (eds.) 
NDBT New Dictionary of Biblical Theology, T. D. Alexander et al. (eds.) 
Neot Neotestamentica 

NHS Nag Hammadi Studies 
NIB   New Interpreter’s Bible 

NICNT New International Commentary on the New Testament 
NICOT New International Commentary on the Old Testament 
NIDNTT The New International Dictionary of New Testament Theology, C. Brown (ed.) 
NIDOTTE The New International Dictionary of Old Testament Theology and Exegesis, W. 

VanGemeren (ed.) 
NIGTC The New International Greek Testament Commentary 
NIVAC NIV Application Commentary 
NJBC The New Jerome Biblical Commentary, R. E. Brown et al. (eds.) 
NovT Novum Testamentum 

NovTSup Novum Testamentum, Supplements 
NPNF Nicene and Post-Nicene Fathers 
NTA New Testament Abstracts 

NTG New Testament Guides 
NTL New Testament Library 
NTS New Testament Studies 

NTTS New Testament Tools and Studies 
Numen Numen: International Review for the History of Religions 
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OCD Oxford Classical Dictionary 

Or Orientalia 

OTA Old Testament Abstracts 

OTE Old Testament Essays 

OTG Old Testament Guides 
OTL Old Testament Library 
OTP The Old Testament Pseudepigrapha, J. H. Charlesworth (ed.) 
OTS Oudtestamentische Studiën 

 
PCB Peake’s Commentary on the Bible, M. Black and H. H. Rowley (eds.) 
PEFQS Palestine Exploration Fund, Quarterly Statement 

PEQ Palestine Exploration Quarterly 

PG J. Migne, Patrologia graeca 

PGM Papyri graecae magicae, K. Preisendanz (ed.) 
PL J. Migne, Patrologia latina 

PNTC Pillar New Testament Commentary 
PRSt   Perspectives in Religious Studies 

PSB   Princeton Seminary Bulletin 

PSTJ Perkins (School of Theology) Journal 

PTMS Pittsburgh (Princeton) Theological Monograph Series 
PTR Princeton Theological Review 

 

QR Quarterly Review 

 
RB Revue biblique 

REC Reformed Expository Commentary 
RefR Reformed Review 

RelS Religious Studies 

RelSRev Religious Studies Review 

ResQ Restoration Quarterly 

RevExp Review and Expositor 

RevQ Revue de Qumran 

RR Review of Religion 

RTR Reformed Theological Review 

 
SBA Studies in Biblical Archaeology 
SBJT   Southern Baptist Journal of Theology 

SBL Society of Biblical Literature 
SBLABS SBL Archaeology and Biblical Studies 
SBLAS SBL Aramaic Studies 
SBLASP SBL Abstracts and Seminar Papers 
SBLBAC SBL The Bible in American Culture 
SBLBMI SBL The Bible and Its Modern Interpreters 
SBLBSNA SBL Biblical Scholarship in North America 
SBLDS SBL Dissertation Series 
SBLMasS SBL Masoretic Series 
SBLMS SBL Monograph Series 
SBLNTGF SBL The New Testament in the Greek Fathers 
SBLRBS SBL Resources for Biblical Study 
SBLSBS SBL Sources for Biblical Study 
SBLSCS SBL Septuagint and Cognate Studies 
SBLSP   SBL Seminar Papers 

SBLTT SBL Texts and Translations 
SBLWAW SBL Writings of the Ancient World 
SBT Studies in Biblical Theology 
SD Studies and Documents 
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Sem   Semitica 

SHT Studies in Historical Theology 
SJLA Studies in Judaism in Late Antiquity 
SJOT   Scandinavian Journal of the Old Testament 

SJT Scottish Journal of Theology 

SNTSMS Society for New Testament Studies Monograph Series 
SOTSMS Society for Old Testament Study Monograph Series 
SP Sacra Pagina 
ST Studia Theologica 

STDJ Studies on the Texts of the Desert of Judah 
STJ   Stulos Theological Journal 

StudBT   Studia Biblica et Theologica 

StVTQ   Saint Vladimir's Theological Quarterly 

SwJT   Southwestern Journal of Theology 

 
TBT The Bible Today 

TCGNT A Textual Commentary on the Greek New Testament, B. M. Metzger 
TD Theology Digest 

TDNT Theological Dictionary of the New Testament, G. Kittel and G. Friedrich (eds.) 
TDOT Theological Dictionary of the Old Testament, G. J. Botterweck and H. Ringgren (eds.) 
TLG Thesaurae Lingua Graecae  
TMSJ The Master’s Seminary Journal 

TNTC Tyndale New Testament Commentaries 
TOTC Tyndale Old Testament Commentaries 
TRev Theological Review 

TrinJ Trinity Journal 

TS Theological Studies 

TSFB Theological Students’ Fellowship Bulletin 

TSK Theologische Studien und Kritiken 

TToday Theology Today 

TWAT Theologisches Wörterbuch zum Alten Testament, G. J. Botterweck and H. Ringgren (eds.) 
TWNT Theologisches Wörterbuch zum Neuen Testament, G. Kittel and G. Friedrich (eds.) 
TWOT Theological Wordbook of the Old Testament, R. L. Harris et al. (eds.) 
TynBul Tyndale Bulletin 

TZ Theologische Zeitschrift 
 

UBSGNT United Bible Societies Greek New Testament 
UF Ugarit-Forschungen 
USQR Union Seminary Quarterly Review 
UT Ugaritic Textbook, C. H. Gordon 
 

VC Vigiliae christianae 
VT Vetus Testamentum 
VTSup Vetus Testamentum Supplements 
 

WBC Word Biblical Commentary 
WEC Wycliffe Exegetical Commentary 
WesTJ   Wesleyan Theological Journal 

WDB Westminster Dictionary of the Bible 
WHAB Westminster Historical Atlas of the Bible 

WTJ Westminster Theological Journal 
WW Word and World 
 

ZAW Zeitschrift für die alttestamentliche Wissenschaft 

ZNW Zeitschrift für die neutestamentliche Wissenschaft 

ZPEB Zondervan Pictorial Encyclopedia of the Bible 

ZTK Zeitschrift für Theologie und Kirche 
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PART 5: CAPITALIZATION OF COMMONLY USED RELIGIOUS TERMS 
(from A Christian Writer’s Manual of Style by Bob Hudson and Shelley Townsend [Zondervan, 1988]  

with additions from The SBL Handbook of Style [Hendrickson, 1999]) 
 

 
Aaronic priesthood 
ablative 
Abba 
abomination of desolation 
Abrahamic covenant 
Abraham’s Bosom 
Abraham’s side 
Abyss, the 
accusative 
ad hoc 
Adapa 
Adonai 
Advent, the 
Advent season 
Advocate, the 
age of grace 
age to come, the 
Age (for archaeological periods, such as Bronze 

Age and Iron Age) 
agnosticism 
agraphon, pl. agrapha 
Akkadian 
Almighty, the 
almighty God 
Aleppo Codex 
Alpha and Omega (Christ) 
Amarna age, letters, tablets 
amillenarian 
amillennial(ism)(ist) 
ancient Near East(ern) 
Ancient of Days, the (God) 
angel (cap. if theophany) 
angel Gabriel, the 
angel of the Lord (cap. if theophany) 
Annunciation, the 
Anointed, the (Christ) 
Anointed One, the (Christ) 

anointing of the sick 
ante-Christian 
antediluvian 
ante-Nicene fathers 
anti-Catholic 
antichrist (the general spirit) 
Antichrist (the person) 
anti-Christian 
antichurch 
antilegomena 
anti-God 
anti-Semitism 
anti-Trinitarian 
Apocalypse, the (Revelation of John) 

apocalyptic 
Apocrypha, the 

apocryphal (cap. only if Apocrypha is meant) 

a posteriori 
apostle Peter et al. 
Apostle to the Gentiles (Paul) 
apostles, the 
Apostles’ Creed 
apostolic age 
apostolic benediction (2 Cor 13) 
apostolic council (Acts 15) 
apostolic faith 
Apostolic Fathers (corpus of writings) 
a priori 
Aramaean 
archangel 
archaeology 

archbishop of Canterbury (but Archbishop Smith) 
ark, the (Noah’s) 
ark of testimony 
ark of the covenant 
Arminian(ism) 
Ascension, the 
Ascension Day 
Assyrian Empire 
Assyrian King List 
Athanasian Creed 
atheism, -ist 
atonement 
Atonement, the 
Atonement, the Day of 
Augsburg Confession 
 
Baal 
baalism 
babe in the manger, the 
baby Jesus, the 
Babylonian captivity (Jews) 
Babylonian Empire 
baptism 
baptism in/with/of the Holy Spirit 
Baptism, the (of Christ) 
Battle of Armageddon (final battle) 
battle of Carchemish, etc. 
Beast, the (Antichrist) 
Beatitudes, the 
Beelzebub 
being 
Being (God) 
Beloved Apostle, the 
Betrayal, the 
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Bible, the 
Bible Belt, the 
Bible school 
biblical 
bishop of Rome (but Bishop Smith) 
blessed name (Christ) 
Blessed Virgin 
blood of Christ 
Bodmer papyrus 
body of Christ (the church) 
Book, the (Bible) 
book of Genesis et al. 
Book of Life (book of judgment) 
Book of the Covenant 
Book of the Law 
Book of the Twelve, the 
Book of Truth 
boy Jesus, the 
brazen altar 
Bread of Life (Bible or Christ) 
Bridegroom, the (Christ) 
bride of Christ (the church) 
brotherhood of man 
burnt offering 
 
call of Amos, etc. 
Calvary 
Calvinist(ic), -ism 
Canon, the (Scripture) 
canon of Scripture, the 
Captivity, the (of the Jews) 
catechumen 
catholic (universal) 
Catholic Church (Roman Catholic) 
Catholic Epistles (James et al.) 
Catholicism 
Celestial City (abode of the redeemed) 
charismatic 
charismatic church 
charismatic movement 
cherub(im) 
chief priest 
Chief Shepherd (Christ) 
child Jesus 
children of Israel 
chosen people (Jews) 
Christ 
Christ child 
christen(ing) 
Christian (n. and adj.) 
Christian era 
Christianize, -ization 
Christianlike 
Christlike 
Christmas Day 
Christmas Eve 

Christmastide 
Christocentrism 
Christology, -ical 
Christophany 
church, the (body of Christ) 
church (building) 
church (service) 
church age 
church and state 
church fathers (the Fathers) 
church in America 
church invisible 
church militant 
Church of England 
Church of Rome 
church triumphant 
church universal 
church visible 
City of David (Jerusalem, Bethlehem) 
City of God 
Classical Greek 
Classical Hebrew 
Codex Alexandrinus, etc. 
Comforter, the (Holy Spirit) 
commandment (first et al.) 
Commandments, the Ten 
Communion (sacrament) 
confirmation 
conquest period 
council 
Council of Trent 
Counselor, the 
covenant, the 
covenant of grace 
covenant of works 
Creation, the (the act) 
creation, the (the result) 
Creator, the 
Cross, the (the event) 
cross (the wooden object) 
crown 
Crucifixion, the 
crucifixion of Christ 
Crusades, the 
Curse, the 
 
daghesh forte/lene 

Daniel’s Seventieth Week 
dative 
Davidic covenant/law/monarchy 
Day of Atonement (Yom Kippur) 
day of grace 
Day of Judgment 
Day of Pentecost 
Day of the Lord 
Dead Sea Scrolls 
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Decalogue 
Defender (God) 
deism, -ist 
Deity, the 
deity of Christ 
Deluge, the (the Flood) 
demon(ic) 
Deuteronomic 
devil, a 
Devil, the (Satan) 
Diaspora 
disciples 
dispensation(alism)(alist) 
dispensation of the Law 
Dispersion, the 
divided kingdom/monarchy (period of history) 
divine 
Divine Father 
divine guidance 
Divine Providence (God) 
Divine Warrior 
Divinity, the (God) 
divinity of Christ, the 
Door, the (Christ) 
doxology 
Dragon, the (Satan) 
Dynasty, Eighteenth, etc. 
 
early church 
early church fathers (cap. as title of work) 
Easter Sunday 
Eastern church 
Eastern Orthodox Church 
Eastern religions 
Eastern Rites 
ecumenism, -ical 
El 
elect, God’s 
Eleven, the 
Elohim 
El Shaddai 
e-mail 
Emmaus road 
emperor, an 
Emperor Nero 
empire, an 
Empire (as in Assryrian Empire, Roman Empire) 
end times, the  
end-times 
Enemy, the (Satan) 
Epiphany 
epistle (John’s epistle et al.) 
epistle to the Romans 
Epistles, the (NT apostolic letters) 
eschatology, -ical 
Eternal, the (God) 

Eternal City (Rome) 
eternal God, the 
eternal life 
eternity 
etymology (ical) 
Eucharist 
eucharistic 
Evangel (any of the four gospels) 
evangelical (adj.) 
evangelicals, -ism 
Evangelist (gospel writer) 
evangelist (someone who evangelizes) 
Evil One, the (Satan) 
Exile, the 
ex nihilo 

Exodus, the (from Egypt) 
extrabiblical 
extreme unction 
 
faith, the (Christianity) 
faith-healing 
Fall, the 
fall of man 
fall of Jerusalem, etc. 
false christs 
False Prophet (of Revelation) 
false prophet(s) 
Farewell Discourses (in John) 
Father, the (God) 
Father of Lies (Satan) 
fatherhood of God 
Fathers, the (of the church) 
feast day 
Feast (meaning Passover) 
Feast of Booths (Sukkoth) 
Feast of Esther (Purim) 
Feast of Firstfruits 
Feast of Tabernacles 
Feast of the Dedication (Hanukkah) 
Feast of the Lights (Hanukkah) 
Feast of the Passover (Pesach) 
Feast of Unleavened Bread 
Festival of Weeks/Booths/Passover/Lights 
Festschrift(en) 
First Adam 
First Advent 
First Cause, the 
first missionary journey 
First Temple period 
firstborn 
Firstborn, the (Christ) 
firstfruits 
first person of the Trinity 
Flood, the 
four gospels, the 
fourth gospel, the 
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free will 
fundamentalist(s), -ism 
fundamentals of the faith 
 
Galilean, the (Christ) 
Garden of Eden 
Garden of Gethsemane 
gehenna 
Gemara 
General Epistles 
genitive 
Gentile, a (distinguished from Jew) 
gentile laws 
Gloria Patri 
gnostic (generic) 
Gnostic(ism) (specific sect) 
God (Yahweh) 
god (pagan) 
Godhead (essential being of God) 
godhead (godhood or godship) 
godless 
godlike 
godly 
God-man 
godsend 
God’s house 
Godspeed 
God’s Word (the Bible) 
God’s word (his promise) 
godward 
golden calf, the 
golden candlesticks, the 
Golden Rule, the 
Good Book, the 
Good Friday 
Good News, the 
Good Samaritan 
Good Shepherd (Jesus) 
good shepherd, the parable of the 
gospel (John’s gospel et al.) 
gospel of Matthew 
Gospels, the 
gospel truth 
grain offering 
Great Awakening, the 
Great Commandment, the 
Great Commission, the 
Great High Priest, the 
Great Judgment, the 
Great Physician, the 
Great Shepherd, the 
Great Tribulation, the 
Great White Throne, the 
Greek 
Ground of Being 
Guide, the (Holy Spirit) 

guilt offering 
 
hades 
haggadah 
Hagiographa 
hagiographer 
hagiographic 
Hail Mary 
halakah 
Hallel 
Hanukkah (Feast of the Dedication) 
hapax legomenon 

Head, the (Christ head of the church) 
heaven (abode of the redeemed) 
heavenly Father 
Heidelberg Catechism 
Heilsgeschichte 
hell 
Hellenism (tic) 
hellenize 
Herodian 
Herod’s temple 
hesed 

high church 
High Priest, the (Christ) 
high priest, a 
High Priestly Prayer, the 
Historical Books, the 
holiness 
Holiness Code (Lev 17–26) 
Holiness Movement, the 
Holy Bible 
Holy Book (Bible) 
Holy City (present or New Jerusalem) 
Holy Communion 
holy day of obligation 
Holy Eucharist 
holy family 
Holy Ghost (prefer Holy Spirit) 
Holy Grail 
Holy Land (Palestine) 
Holy of Holies 
holy oil 
Holy One, the (God, Christ) 
holy order(s) 
Holy Place 
Holy Roller 
Holy Saturday 
Holy Scriptures 
Holy See 
Holy Spirit 
Holy Thursday 
Holy Trinity 
holy war 
holy water 
Holy Week (before Easter) 
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Holy Writ (Bible) 
Holy Year (Catholic) 
homologoumena 

house of David 

house of the Lord 

humanity 
 
idolatry  
imago Dei 

Immaculate Conception, the 
Immanuel 
Incarnation, the 
incarnation of Christ 
infant Jesus, the 
inner veil 
Intercessor, the (Christ) 
intertestamental 
ipsissima verba 

ipsissima vox 

Isaian or Isaianic 
 
Jacob’s Trouble 
Jehovah 
Jeremian or Jeremianic 
Jerusalem Council 
Jesus Prayer, the 
Jewish Feast (Passover) 
Jewish New Year (Rosh Hashanah) 
Jewish War 
Johannine 
John the Baptist 
John the Beloved 
John the Evangelist 
Jordan River (but the river Jordan) 
Jubilee (year of emancipation) 
Judaic 
Judaica 
Judaism, -ist, -istic 
Judaize(r) 
Judea(n) 
Judeo-Christian 
judges, the 
Judgment Day 
judgment seat of Christ 
 
kerygma 
Kethib 
Ketubim or Ketuvim 
Khirbet 
King (God or Jesus) 
King James Version 
kingdom, the 
kingdom age 
kingdom of God 
kingdom of heaven 
kingdom of Israel 

kingdom of Satan 
King of Glory (Christ) 
King of Kings (Christ) 
kingship of Christ 
Kinsman-Redeemer 
koinonia 
Koran, koranic (prefer Qur’an) 
 
Lachish letters 
Lady, our 
lake of fire 
Lamb, the (Christ) 
Lamb of God 
Lamb’s Book of Life 
land of Canaan 
Land of Promise 
land of Israel 
Last Day, the 
last days, the 
Last Judgment, the 
last rites 
Last Supper, the 
last times, the 
Latin Rite 
Latter Prophets 
laver 
law (as opposed to grace) 
Law, the (Pentateuch) 
Law of Moses, the 
law of Moses, a (general) 
Lawgiver (God) 
lemma 
Leningrad Codex 
Lent(en) 
Letter of Aristeas 
Letter to the Romans, etc. 
levirate 
Levitical 
Levitical decrees 
liberal(ism) 
Light (Truth or Christ) 
Light of the World (Christ) 
lingua franca 
Litany, the (Anglican) 
Literature, Second Temple, etc. 
living God 
living Word, the (Bible) 
Logos, the 
Lord, the 
Lord of Hosts 
Lord of Lords 
Lord’s Anointed, the (Christ) 
Lord’s Day, the 
lordship of Christ 
Lord’s Prayer, the 
Lord’s Supper, the 
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Lord’s Table, the 
lordship 
lordship of Christ 
lordship salvation 
Lost Tribes 
lost tribes of Israel 
Love Chapter, the 
low church 
Lower Egypt (political division) 
lower Galilee (geographical division) 
Lukan 
 
Magi 
Magnificat, the 
Major Prophets, the (div. of OT) 
major prophets (people) 
Majority Text 
Maker, the (God) 
mammon 
Man, the (Jesus) 
Man of Sin 
Man of Sorrows 
Marcan or Markan 
Masorete 
masoretic (but Masoretic Text) 
Mass (liturgy of the Eucharist) 
matrimony 
Matthean 
Mediator, the (Christ) 
medieval 
Megillah (oth) 
mercy seat 
messiah (general) 
Messiah, the (Christ) 
messiahship 
messianic 
Middle Ages 
Middle Assyrian period 
Middle Babylonian period 
middle Euphrates 
midtribulation(al) 
millenarian(ism)(ist) 
millennial kingdom 
Millennium, the 
Minor Prophets, the (div. of OT) 
minor prophets (people) 
minuscule 
Miserere, the 
Mishnah 
modernist(s), -ism 
moon-god 
Mosaic 
Mosaic covenant 
Mosaic Law (Pentateuch or Ten Commandments) 
Most High, the 
Mount of Olives 

Mount of Transfiguration 
Mount Olivet 
Mount Olivet Discourse 
Mount Sinai 
Muhammad (preferred) 
Muratorian Fragment/Canon 
Muslim (preferred) 
 
Nag Hammadi codices 
name of God/Christ, the 
Nativity, the 
nativity of Christ, the 
Near East 
Nebiim or Nevi’im 
Negev (not Negeb) 
Neo-Assyrian period (but Neo-Assyrian Empire) 
Neo-Babylonian period (but Neo-Babylonian 

Empire) 
neo-evangelical 
neo-orthodox(y) 
neo-pentecostalism 
Neoplatonic 
new birth 
New City (part of modern Jerusalem) 
new covenant (NT) 
new evangelical 
new heaven and new earth 
New Jerusalem (heaven) 
New Testament church 
Nicene Creed 
Nicene fathers 
Ninety-five Theses 
noncanonical 
non-Christian (n. and adj.) 
non-Pauline 
Nonconformism, -ist 
northern kingdom 
Northwest Semitic 
Nunc Dimittis 
 
Old Assyrian period 
Old Babylonian period 
Old City (part of modern Jerusalem) 
old covenant (OT) 
Olivet discourse 
Omega, the 
Omnipotent, the 
One, the (but the one true God) 
Only Begotten, the 
only begotten of the Father 
only begotten Son of God 
oral law/tradition 
original sin 
orthodox(y) (general) 
Orthodox Jew 
outer court (of the Temple) 
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Palestinian covenant 
Palm Sunday 
papacy 
papyrus (pl. papyri) 
parable of the prodigal son, etc. 
Paraclete, the 
paradise (heaven) 
Paradise (Garden of Eden) 
Parousia, the 
partial Rapture 
Paschal Lamb (Jesus) 
passion, the 
Passion Sunday (fifth Sunday in Lent) 
Passion Week 
Passover 
Passover Feast 
Passover Lamb (Jesus) 
Pastoral Epistles 
Pastoral Letters 
Patriarch, the (Abraham) 
patriarch, a 
patristic(s) 
Paul the apostle 
Pauline Epistles 
Paul’s epistles 
Paul’s letters 
peace offering 
penance 
Pentateuch 
pentateuchal 
Pentecost 
pentecostal (adj.) (but Pentecostal Movement) 
Pentecostal(ism) (noun) 
people of God 
people of Israel 
period (as in Roman period, Chalcolithic period) 
person of Christ 
(the three) persons of the Trinity 
Pesach (Passover) 
Petrine 
Pharaoh (when used as name without article) 
pharaoh, a (general) 
pharisaic (attitude) 
Pharisaic (in reference to Pharisees) 
Pharisee 
Pilgrims, the 
pillar of cloud 
pillar of fire 
Poetic Books, the 
pope, the 
Pope John Paul II 
postbiblical 
post-Christian 
postdiluvian 
postexilic 

postmillennial(ism)(ist) 
post-Nicene fathers 
pre-Christian 
predestination 
premillenarian 
premillennial(ism)(ist) 
pretribulation(al) 
priesthood of believers 
priesthood of Christ 
Priestly Code 
Prime Mover 
Prince of Darkness 
Prince of Peace (Christ) 
Prison Epistles 
Prison Letters 
Prodigal Son, the 
Promised Land (Canaan or heaven) 
Promised One, the (Christ) 
prophecy of Isaiah (etc.), the 
prophet Isaiah (etc.), the 
Prophetic Books, the 
prophets, the (people) 
Prophets, the (books of OT) 
Protestant(ism) 
Proto-Sinaitic 
Proto-Semitic 
Providence (God) 
providence of God 
providential 
Psalm 119 (etc.) 
Psalms, the (OT book) 
psalm, a 
psalmic 
psalmist, the 
Psalter, the (the Psalms) 
Pseudepigrapha, the 
pseudepigraphal 
purgatory 
Purim (Feast of Esther) 
 
Qere 
Qumran 
Qur’an 
 

rabbi 

rabbinic(al) 
Rapture, the 
real presence 
Received Text, the 
Redeemer, the 
Reformation, the 
Reformed church 
Reformed theology 
Reformers 
Resurrection, the 
resurrection of Christ 
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return (of Christ) 
rite(s) 
Rock, the (Christ) 
Roman Catholic Church 
Roman Empire 
Roman Rite 
Rosh Hashanah (Jewish New Year) 
Royal psalm(s) 
 
Sabbath (day) 
sabbatical (n. and adj.) 
sacrament(s) 
sacramentalism, -ist 
Sacramentarian(ism) 
Sacred Host 
sacred rite(s) 
Sadducee 
Sanhedrin 
Satan 
satanic 
satanism 
Savior (referring to Jesus) 
scribe (-al) 
scriptural 
scripture, a 
Scripture(s), the (Bible; n. and adj.) 
scripture(s) (other religions) 
Second Adam (Christ) 
Second Advent, the 
Second Coming, the 
second coming of Christ 
Second Council of Nicea 
second missionary journey 
second person of the Trinity 
Second Temple period/literature 
seder 
Semite, -ic, -ism 
sensus plenior 
Septuagesima 
Septuagint 
seraph(im) 
Sermon on the Mount/Plain 
Serpent, the (Satan) 
seven sacraments, the 
Seventh-day Adventist 
Seventieth Week 
Shabuoth (Pentecost) 
shalom 
shalom aleichem 
Shechinah 
Shema, the 
sheol 
Shepherd Psalm, the 
Shulammite 
Sin-Bearer, the 
sin offering 

Sitz im Leben 
Solomon’s temple 
Son of God 
Son of Man 
Song of Moses 
sonship of Christ 
southern kingdom 
Sovereign Lord 
Spirit, the 
Spirit Baptistm 
stations of the cross 
stela (pl. stelae) 
Suffering Servant 
Sukkoth (Feast of Booths) 
Sunday school 
sun-god 
Sun of Righteousness 
Supreme Being, the 
Sustainer (God) 
synagogue 
Synoptic Gospels 
Synoptic Problem 
synoptic writers, the 
synoptics, the 
 
tabernacle, the (OT building) 
table of shewbread 
Talmud 
talmudic 
Tanach 
Targum 
Targum of Jonathan, etc. 
targumic 
Te Deum 

tell 
Tell Dan, etc. 
temple, the; Solomon’s temple 
Temple Mount 
Temptation, the 
temptation in the desert, the 
temptation of Christ, the 
Ten Commandments (but the second  

commandment) 
Ten Tribes, the 
ten tribes of Israel, the 

tent 
Tent of Meeting 
Tent of the Testimony 
Testaments, the 
Textus Receptus 
third person of the Trinity 
third missionary journey 
Thirty-nine Articles (Anglican) 
throne of grace 
Thummim 
Time of Jacob’s Trouble 
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Time of the Gentiles, the 
time of the judges, the 
tomb, the 
Torah 
Tower of Babel 
Transfiguration, the 
Transjordan 
Tree of Knowledge of Good and Evil 
Tree of Life 
tribe of Judah 
Tribulation, the (historical event) 
Trinitarian 
Trinity, the 
Triumphal Entry 
triune God 
Twelve, the 
twelve apostles, the 
Twenty-third Psalm 
 
unchristian 
Uncial 

ungodly 
united kingdom (of Israel) 
universal church 
universalism, -ist 
unscriptural 
Upanishads 
Upper Egypt (political division) 
upper Galilee (geographical division) 
Upper Room, the 
Upper Room Discourse 
Urim and Thummim 
 
vacation Bible school 
Vedas, Vedic 
viaticum 
Victor, the (Christ) 
Vine, the (Christ) 
Virgin Birth, the 
Virgin Mary, the 
visible church 
Vulgate 
 
wadi 
Wadi Qelt, etc. 
Water of Life (Christ) 
Way, the (Christ) 
Way, the Truth, and the Life 
West Semitic 
Western church/text 
Western Rites 
Westminster Catechism 
whole burnt offering 
Wicked One, the (Satan) 
Wisdom Literature, the 
wise men 

Word, the (Bible or Christ) 
Word made flesh (Christ) 
Word of God (Bible) 
Word of Life 
Word of Truth, the 
Writings, the 
 
Yahweh 
Year of Jubilee 
Yom Kippur (Day of Atonement) 
Yuletide 
 
Zealots 
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Title: THE BLASPHEMY AGAINST THE HOLY SPIRIT 
Author: William W. Combs 
Degree: Doctor of Theology 
Date: May 1985 
Advisers: John A. Sproule, David L. Turner, and George J. Zemek 
 
 

In the Gospels Jesus makes reference to the blasphemy against the Holy Spirit, or, as 
it is often called, the unpardonable sin. The interpretation of Jesus’ words and their 
application has been a problem throughout the church’s history. The purpose of this 
dissertation was to examine Jesus’ statements from a detailed historical, exegetical, and 
theological perspective in order to hopefully shed new light on the problem and come to a 
conclusion which is fully supported by all the data. 

The first step was to undertake a historical survey of how the sin has been interpreted 
in church history. Next, the passages in the Gospels themselves were studied. This involved a 
detailed exegesis of the accounts in Matthew, Mark, and Luke. After the Gospels had been 
dealt with, attention was turned to Hebrews 6 and 1 John 5:16 since these passages are 
sometimes thought to be also referring to the blasphemy against the Holy Spirit. Although a 
detailed exegesis of these passages was not attempted, it was demonstrated that neither of 
these passages had any bearing upon the interpretation of the sin in the Gospels. Finally, the 
historical and exegetical data from the previous chapters was brought to bear on a fresh 
analysis of the sin. The major areas of debate were considered under the headings of four 
questions: (1) What is the precise nature of the sin? (2) Why is the sin unpardonable? (3) 
Who can commit the sin? (4) Can the sin be committed today? 

It was concluded that the sin consisted in blaspheming the miracle-working power of 
the Holy Spirit. The sin is never forgiven because God chooses not to grant repentance for 
this sin and the sinner simply remains in his depraved condition. It was also shown that only 
unbelievers are capable of committing the sin. Because of the nature of the sin itself, it can 
only be committed during a period of supernatural sign-miracles such as during the ministry 
of Jesus, his Apostles, or possibly during the future ministry of the two witnesses in 
Revelation 11. 
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[Sample Headings—M.Div. and Th.M. Classroom Papers] 
 

 

 
 
[2” from top] PAPER TITLE            

Major Heading 

 As a section heading, the paper title appears in ALL CAPS preceded by a two-inch 

upper margin and followed by two blank single-spaced lines. It is followed immediately by 

the first major heading, usually the introduction. Major headings appear in bold font. Bold 

font appears nowhere else in the paper. No heading should exceed 5 inches. If a heading 

exceeds this length, divide into two lines in an inverted pyramid, using single spacing.  

First Level Subheading 

All headings are preceded by two blank single-spaced lines and followed by one 

blank single-spaced line. Major headings and centered subheadings are capitalized in 

headline style, that is, capitalize the initial letter of the first and last words and of all words 

except articles, prepositions of four letters or fewer, and coordinate conjunctions.1 

SECOND LEVEL SUBHEADING 

Second level subheadings are exactly like the first level except they are not italicized. 

Third level subheading 

Third level subheadings appear on the left margin in sentence capitalization style.  

Fourth level subheading 

 Fourth level subheadings are exactly like the third level except they are not italicized. 

Term papers of normal classroom length do not require additional subheadings.  

________________________ 
  
 

1
Footnotes are indented ½ inch. The text begins immediately after the footnote number (the default 

setting on Word leaves a space). Footnotes appear in either 10 or 12 point font at to the preference of the writer. 

Footnotes are separated from the text by a two-inch separator line and a single space. Footnotes appear at the 

bottom of the page, even if text fills only part of the page. Separate footnotes from each other by a single space. 

  
1 
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[Sample Headings—Th.M. Thesis] 
 

 

 
 
[2” from top] CHAPTER I           [center over text, not page] 
       

CHAPTER TITLE 
 

Note that the thesis title does not appear in the text of the thesis. Instead, the thesis is 

written in chapters, each chapter appearing as a section header (ALL CAPS preceded by a 

two-inch upper margin and followed by two blank single-spaced lines). Chapter titles replace 

the bold major headings of normal classroom papers, so the latter heading is not used in 

theses. Note that this requires text between the chapter title and the next subheading: it is not 

permissible to have two headings following each other without some intervening text. 

First Level Subheading 

Apart from these changes, the thesis is exactly as the normal classroom paper. No 

heading or subheading should exceed 5 inches. If a heading exceeds this length, divide into 

two lines in an inverted pyramid, using single spacing. All headings are preceded by two 

blank single-spaced lines and followed by one blank single-spaced line. Capitalize centered 

subheadings in headline style, that is, capitalize the initial letter of the first and last words and 

of all words except articles, prepositions of four letters or fewer, and coordinate conjunctions. 

SECOND LEVEL SUBHEADING 

Second level subheadings are exactly like the first level except they are not italicized. 

Third level subheading 

Third level subheadings appear on the left margin in sentence capitalization style.  

Fourth level subheading 

 Fourth level subheadings are exactly like the third level except they are not italicized. 

Theses should be organized so that additional subheadings are unnecessary.  

 
1
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[Sample Text Pages—M.Div. and Th.M. Classroom Papers] 
 
 
 

 
THE PRE-MOSAIC TITHE: 

ISSUES AND IMPLICATIONS 
 
 

Introduction  

 In Leviticus 27 the Mosaic Law expressly commands the practice of tithing, 

codifying it for all Israel as a combined act of spiritual service and economic obligation for 

the advancement of the nation. This codification, however, was by no means the birth of the 

tithe, but a new expression of a more ancient tithe infused with theological significance for 

the new political entity of Israel.1  

It is well attested that the tithe2 was present in the very earliest of cultures—Roman, 

Greek, Carthaginian, Cretan, Silician, Phoenician, Chinese, Babylonian, Akkadian, and 

Egyptian—stretching back to the earliest written records of the human race.3 Was the tithe a 

divinely conceived custom, original with Yahweh and unique in its expression, or was tithing 

a divine adaptation of an originally pagan custom, bequeathed with theological significance 

by divine fiat? Further, was the tithe an act of worship alone, or a demonstration of political 

subservience—a primitive form of taxation? Or was it a combination of the two? 

Many scholars (including most liberals) contend that the levitical institution was 

borrowed strictly from early contemporary heathen practices.4 On the other pole, some,  

                                            
 

1Henry Landsell, The Sacred Tenth or Studies of Tithe-Giving, Ancient and Modern (Grand Rapids: 
Baker, 1955), p. 56.  

2The author intends the term in its technical sense—a tenth. As John E. Simpson notes of the nearly 
universal pagan practice of tithing, “the amount so given was almost invariably one-tenth” (This World’s Goods 
[New York: Revell, 1939], p. 88). Cf., however, Joseph M. Baumgarten, “On the Non-literal Use of 
Maaser/Dekate,” JBL 103 (June 1984): 245–51. 

3Landsell, Sacred Tenth, pp. 1–38; Arthur Babbs, The Law of the Tithe As Set Forth in the Old 
Testament (New York: Revell, 1912), pp. 13–24; E. B. Stewart, The Tithe (Chicago: Winona Publishing Co., 
1903), pp. 7–13.  

4H. Jagersma, “The Tithes in the Old Testament,” in Remembering All the Way, OTS XXI (Leiden: 
Brill, 1981), pp. 116–28; Marvin E. Tate, “Tithing: Legalism or Benchmark?” RevExp 70 (Spring 1973): 153;  

 
1 
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generally more conservative, scholars contend that the universality of the tithe and the  

exhaustion of attempts to discover its origin within secular sources point to a much more 

ancient practice—one instituted by God at the very dawn of human history.5  

To make either claim, one must look to the early chapters of Genesis for clues to the 

genesis of the tithe. It is, therefore, the purpose of the following essay to probe the OT 

material, beginning with the sacrificial practices of Cain and Abel, continuing with the 

unprecedented payment of tithes by Abram to the priest of the most high God, Melchizedek, 

and concluding with Jacob’s intention to tithe, for clues to the genesis of the pre-Mosaic 

tithe. This essay will then decide whether sufficient evidence exists to confirm its divine 

origin, then discuss briefly its relationship to the levitical tithe and its continuing applicability 

(or non-applicability) today. 

The Giving Practices of Cain and Abel (Genesis 4:3–7) 
 

So it came about in the course of time that Cain brought an offering to the LORD of 
the fruit of the ground. Abel, on his part also brought of the firstlings of his flock and of their 
fat portions. And the LORD had regard for Abel and for his offering; but for Cain and for his 
offering He had no regard. So Cain became very angry and his countenance fell. Then the 
LORD said to Cain, “Why are you angry? And why has your countenance fallen? If you do 
well, will not your countenance be lifted up? And if you do not do well, sin is crouching at 
the door; and its desire is for you, but you must master it.”6 

In an attempt to establish the continuity of the tithe throughout human history, several 

older conservative scholars adopted an alternative text and translation to affirm that Cain’s 

bel’s sacrifices establish tithing as early as Genesis 4. The LXX reading of verse 7 apparently 

eflects the Hebrew jtnl(to dissect or divide) rather than the MT’s jtpl (reflected in NASB’s 

“at the door”). The resulting English translation of verse 7 identifies Cain’s sin as his failure 

to “divide rightly.” Furthering this conclusion is an alternate reading of a NT text, Hebrews 

                                            
 

EncJud, s.v. “Tithe,” by M. Weinfeld; IDB, s.v. “Tithe,” by H. H. Guthrie, Jr. Included in this group are all 
those who view Israel’s “cultus” as evolutionary and not revelational.  

5Landsell, Sacred Tenth, p. 38; Babbs, Law of the Tithe, pp. 24–25.   

6All Scripture quotations, unless otherwise noted, are taken from the 1995 edition of NASB.  
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[Sample Text Pages—Th.M. Thesis] 

  

 

CHAPTER III 

ISSUES IN NT INTERPRETATION 

The Nag Hammadi library was discovered over thirty-five years ago, but because all 

of the tractates have only recently been published, the interpretation of the library is only just 

beginning. Already, however, some major issues of interpretation in relation to the NT have 

arisen. 

 

Pre-Christian Gnosticism 

Probably most of the discussion about the contents of the library has centered around 

its contribution to the question of pre-Christian Gnosticism. Until the twentieth century, the 

prevailing view of Gnosticism was that of the Church Fathers, who held that it was a 

Christian heresy. Early in this century this view was challenged by the 

Religionsgeschichtliche Schule or “History of Religions School.”12 This approach 
 

represents the most thorough-going application of a naturalistic historicism to the study 
of the Bible. It assumes that biblical religion, in both the Old and New Testaments, 
passed through stages of growth and evolution like all ancient religions, and in this 
evolution was heavily influenced through interaction with its religious environment. This 
method involves the consistent application of the principle of analogy to biblical religion: 
the history and development of biblical religion must be analogous to the history and 
development of other ancient religions.13 

The leading spokesmen of the History of Religions School, Wilhelm Bousset (1865–

1920) and Richard Reitzenstein (1861–1931), argued upon the basis of Hermetic, Iranian, 

and  Mandaean documents, all of which postdated the NT, that Gnosticism existed prior to 
 

____________________ 
 

12
For an excellent discussion of the History of Religions School, see George E. Ladd, The New 

Testament and Criticism (Grand Rapids: Eerdmans, 1967), pp. 195–214. 
 
13Ladd, The New Testament and Criticism, p. 196. 
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Christianity.14 Rudolf Bultmann adopted the idea of pre-Christian Gnosticism and sought to  

explain NT Christianity as the result of a syncretistic process which included Gnostic ideas.15 

Most German NT scholars, because of the influence of Bultmann, have assumed a pre-

Christian Gnosticism as a basis for their interpretation of the NT. For example, one of 

Bultmann’s students, Walter Schmithals, seems to be able to find Gnosticism in almost every 

Pauline letter.16A number of Bultmann’s disciples are attempting to use the Nag Hammadi 

library in order to verify his view of NT Christianity. MacRae has announced in a recent 

article: “It is my contention here that such evidence as we have now in the Nag Hammadi 

library tends to vindicate the position of Bultmann.”17 

 
Problem of Definition 

A vital consideration with regard to the question of pre-Christian Gnosticism is the 

need for defining Gnosticism itself. Evans has noted that “if Gnosticism is defined broadly 

then its origins are found to be much earlier and its roots quite diverse. However, if it is 

defined narrowly, Gnosticism may be viewed as an early Christian heresy and thus 

subsequent to the origin of Christianity.”18 Wilson has suggested that one solution to the 

problem of definition would be to distinguish between Gnosticism and Gnosis: “By 

Gnosticism we mean the specifically Christian heresy of the second century A.D., by Gnosis, 

in a broader sense, the whole complex of ideas belonging to the Gnostic movement and 
 
________________________ 

 
14Edwin M. Yamauchi, “Some Alleged Evidences for Pre-Christian Gnosticism,” in New Dimensions 

in New Testament Study, ed. Richard N. Longenecker and Merrill C. Tenney (Grand Rapids: Zondervan, 1974), 
p. 47. 

 
15Rudolf Bultmann, Theology of the New Testament, 2 vols., trans. Kendrick Grobel (New York: 

Scribner’s, 1951–55), 1:164. 
 
16See his Gnosticism in Corinth, trans. John E. Steely (Nashville: Abingdon, 1971) and Paul and the 

Gnostics, trans. John E. Steely (Nashville: Abingdon, 1972). 
 
17George W. MacRae, “Nag Hammadi and the New Testament,” in Gnosis: Festschrift für Hans Jonas, 

ed. Barbara Aland (Göttingen: Vandenhoeck and Ruprecht, 1978), p. 146. 
 
18Craig A. Evans, “Current Issues in Coptic Gnosticism for New Testament Study,” Studia Biblica et 

Theologica 9 (October 1979): 98. 
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related trends of thought.”19 Unfortunately, some scholars feel that such distinctions are too  

confining. MacRae refuses to abide by Wilson’s guidelines, suggesting that “it is not the 

terminology that matters most.”20 Bultmann uses the term die Gnosis, but his translators 

render it into English by the term Gnosticism. German scholars prefer to use the term die 

Gnosis in the widest possible sense. 

It is the opinion of this writer that it is essential to follow the distinctions between 

Gnosis and Gnosticism suggested by Wilson. However, even if the term “Gnosticism” is 

restricted to the second and third century sects, it is still difficult to come up with a definition 

which will incorporate the variety of developed Gnostic systems. Yamauchi believes that the 

essential “element of any developed Gnosticism would be a radical dualism between the 

divine and the created, inasmuch as a fundamental Gnostic tenet is the view that the creation 

of the world resulted from ignorance and error.”21 Wilson has suggested a four-point 

summary of the second century movement: 
  

(1) A distinction between the unknown and transcendent true God on the one hand and 
the Demiurge or creator of this world on the other, the latter being commonly identified 
with the God of the Old Testament; (2) the belief that man in his true nature is 
essentially akin to the divine, a spark of the heavenly light imprisoned in a material body 
and subjected in this world to the dominance of the Demiurge and his powers; (3) a myth 
narrating some kind of pre-mundane fall, to account for man’s present state and his 
yearning for deliverance; and (4) the means, the saving gnosis, by which that deliverance 
is effected and man awakened to the consciousness of his own true nature and heavenly 
origin. This deliverance, and the eventual return of the imprisoned sparks of light to their 
heavenly abode, means in time the return of this world to its primordial chaos, and is 
strenuously opposed at all points by the hostile powers.22 

Wilson’s four basic points are probably as precise as one can be in formulating a 

definition of Gnosticism which will include all the second century sects. The question then is  
 
 
________________________ 

 
19R. McL. Wilson, Gnosis and the New Testament (Philadelphia: Fortress, 1968), p. 9. 

 
20MacRae, “Nag Hammadi and the New Testament,” p. 146. 
 
21Yamauchi, “Some Alleged Evidences for Pre-Christian Gnosticism,” p. 47. 
 
22Wilson, Gnosis and the New Testament, p. 4. 
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